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Sept 2012/2012.1 EE and 2012 SE | Rebranded for QAD 2012.1 EE -
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Course Description

QAD designed this course to cover the basics of using the QAD .NET User Interface (NET UI)
with both QAD Enterprise Applications Standard Edition (SE) and Enterprise Edition (EE).
The course includes:

« Anintroduction to the QAD .NET Ul

- Navigating the QAD .NET Ul
Application help options
QAD .NET Ul programs
Basics of browses

An introduction to the character user interface

Students will also learn by labs designed to reinforce concepts presented in this training guide.

Objective

Learn how to navigate QAD Enterprise Applications using the QAD .NET Ul. In addition,
students will be able understand the help options, different types of programs, and be able to use
browses effectively.

Benefits

Students will become more efficient in the use of QAD Enterprise Applications.

Audience
- Implementation consultants
« Members of implementation teams
« Key users

Prerequisites

Students should have some familiarity with Enterprise (EE) and Standard (SE) editions of QAD
Enterprise Applications.

Course Credit and Scheduling

This course is designed to be taught in two days.

MQAD



About This Course 3

Virtual Environment Information

This guide applies to both the Standard Edition and the Enterprise Edition of QAD Enterprise
Applications. Use the hands-on exercisesin this book with the latest Enterprise Edition learning
environment in the 10USA > 10USA CO workspace. When prompted to log in, specify demo for
user 1D and gad for password.

Note Usersof Standard Edition should complete the exercises in the EE environment; the
concepts are the same in both environments and can be applied to Standard Edition. Features that
only apply to Enterprise Edition are noted in the text.

Additional Resources

If you encounter questions on QAD software that are not addressed in this book, several resources
are available. The QAD corporate Web site provides product and company overviews. From the
main site, you can access the QAD Learning or Support site and the QAD Document Library.
Access to some portions of these sites depends on having a registered account.

http://www.qgad.com/

QAD Learning Center

To view availabletraining courses, locations, and materials, use the QAD Learning Center. Choose
Education under the Services tab to access this resource. In the Learning Center, you can reserve a
learning environment if you want to perform self-study and follow atraining guide on your own.

QAD Document Library

To access release notes, user guides, training guides, and installation and conversion guides by
product and release, visit the QAD Document Library. Choose Document Library under the
Support tab. In the QAD Document Library, you can view HTML pages online, print specific
pages, or download a PDF of an entire book.

To find aresource, you can use the navigation tree on the left or use a powerful cross-document
search, which finds all documents with your search terms and lets you refine the search by book
type, product suite or module, and date published.

QAD Support

Support also offers an array of tools depending on your company’s maintenance agreement with
QAD. These include the Knowledgebase and QAD Forums, where you can post questions and
search for topics of interest. To access these, choose Visit Online Support Center under the Support
tab.

MNQAD
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Objective

Chapter Objective
« Students will be introduced to the following
in the QAD .NET Ul:

- The different types of Ul mode in QAD
Enterprise Applications

- Attributes of component-based and non-
component based programs

- The QAD .NET Ul Login window

MQAD
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Benefits

Chapter Benefits

« Students will understand the following in the
QAD .NET Ul:

- The different Ul modes available in QAD
Applications

- The different attributes of component-

based and non-component based
screens

- How to log in to the QAD .NET Ul

MNQAD
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Training Flow

Training Flow

* Introduction

+ Navigation

+ Application Help
- Programs

- Browses

« Character Ul

- Dashboards

MQAD
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Introduction — QAD .NET Ul

Introduction
« The QAD .NET Ul

- Microsoft Technology
* Incorporates familiar Ul features
* Reduces learning effort by users
- One interface, two modes
+ QAD .NET Ul
« Terminal Mode (rendering of Character Ul)

MNQAD
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Character Ul

Character Ul

P 172.16.28.81 - PuTTY o
|

QHI : gaddb-
mfmenu Hain Menu 05/26/10
1. Items/Sites 13. Product Structures 25. General Ledger
2. Addresses 14. Routings/Work Center 26. Multiple Currency
3. Inventory Control 15. Formula/Process 27. Accounts Receivahle
4. Warehousing 16. Work Orders 28. Accounts Payable
5. Purchasing 17. Lean Hanufacturing 29. Tax Management
& 18. Repetitive 30. Cost Management
7. Sales Orders/Invoice 19. Quality Hanagement 31. Banking/Cash Mgmt
8. Configured Products 20. Product Line Plan 32. Fixed Assets
Da 21. Resource Plan 33. Enterprise Ops Plan
io. 22. Forecast/Haster Plan 34.
11. Service/3Support 23. Materials Rgmts Plan 35. EDI eCommerce
1z. Distribution Plan 24. Capacity Romts Plan 36. System Admin
Please select a function. F4 or blank to EXIT .
Fress FZ for Help ™

Unlike the QAD .NET user interface, the character user interface depends completely on input
from the keyboard. Because it is not a graphical user interface, all navigation is based on:

+ A command-prompt interface to execute programs
« Combinations of keystrokes to issue commands within programs
» Navigation without use of a mouse through the UNIX character interface.
Component-based functions are accessible only through the QAD .NET UI. You cannot access any

of these functions from the character Ul. Chapter 6, “Using the Character Ul,” on page 115
discusses this Ul in more detail.

MQAD
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Terminal Mode in the QAD .NET UI

Iterm Master Maintenance X.

Terminal Mode in the QAD .NET Ul

Fromo Group:

Ttem Number: [ Description:
Unit of Measure:
ITtem Data
Prod Line: Item Type: Drawing:
Added: Status: Revision:
Design Group: Group: Drawing Loc: Size:

Price Break Category:

ABC Class:
Lot/Serial Control:
Site:

Location:

Location Type:
Auto Lot Numbers:
Lot Group:

Article Number:

HNo

Item Inventory Data

Average Interval:
Cycle Count Interval:
Shelf Life:
Allocate Single Lot: No
Key Item: No
PO Receipt Status:
WO Receipt Status:

Memo Order Type:

Rctive: No
Active: No

With the QAD .NET Ul interface, you can still use non-component based programsin a CHUI
interface. You do this by selecting Terminal mode in the Program Properties option. Thisis
described in Chapter 2 in the topic “ Properties Options: Open With” on page 30.

MNQAD
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Attributes of Component-Based Programs

Aftributes of Component-Based Screens

- Underlying Microsoft .NET technology
 Traditional Windows screen navigation
- Familiar click and point functions

- Right-click options

MQAD
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Component-Based QAD .NET Ul Screen

Component-Based Screen

Journal Entry Create *

4 GoTo ~ Actions ~ % Tools »| # Attach | & Print s Preview

3

Cusrency View (TransactionCuniency = | Total TC

Saveand Create ] |

Attachments
Yo d | 08 Pasting Diste oa/30200 -
Dapbook Code » |¢| DDODDOCOO Save As Template
Descrption Template Code Replacemant
Orignal Posting 000000000
Felerence
GL Account ¢ GL Desciphion ¢ SubccountC 4 CostCe ¢ Descriphion ¢ Trans 4 TCDebd ¢ TC Credit

)

You use traditional mouse clicks, tabs, and keyboard tabbing to navigate the component-based

screen.

MNQAD
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Attributes of Non-Component Based Screens

Aftributes of Non-Component Based Screens
A rendering of the Character Ul for the .NET
Ul

- Similar tabbing and keyboard navigation

Screen navigation bar for some non-
component based screens
- Enabledin Tools | Options

Non-component based screens are based on traditional procedural-written Progress-based
technology.

MQAD



Introduction to QAD .NET Ul 15

Non-Component Based QAD .NET Ul Screen

Non-Component Based Screen

[Sales Order Maintenance -
# GoTo ~ Actions ~ Copy ~ 5 Print s/ Preview & Aftach
Sales Order (»)  Drder.
Header Lines
> Header » 4 » > >
Header
Order || SoldTo Bil Tor
Sold-Ta Ship-Ta
Details
Order Date: Line Pricing: Confirmed:
Required D ate: Manual Currency:
Fromise D ate Daybook Sel T anable
Due Date: Channel
Perform D ate: Project:

Ship-Ta

Language:

Fised Pnce;
Credt Tems:

All Standard Edition are non-component based. All Enterprise Edition programs except QAD
Enterprise Financials and some related system administration functions are also hon-component

based.

MNQAD
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Login Menu

Login Menu

Login |

FRAQAD

Enterprise Applications

User. \ |
Password: | |

Log on to: igadui - |

Starting the QAD .NET Ul
To launch the client, select the QAD Applicationsicon or menu item under Programs on the Start

menu. Enter your assigned user ID and password. Select a system environment for which you have
permissions from the drop-down menu.

MQAD
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Summary

Chapter Summary

There are different types of Ul mode within
the QAD .NET Ul

Component and non-component based
screens have different visual and navigation
afttributes

You launch the QAD .NET Ul from a menu
option or desktop icon and select an
environment from the drop-down menu

Exercise and Knowledge Check

1 You can use the mouse for certain functions in Terminal mode. (T/F)

2 Some component-based functions are configurable in Terminal mode. (T/F)

3 Which of the two interfaces depends completely on input from the keyboard?
4 Which Enterprise Edition application is component based?

MNQAD
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Objective

Chapter Objectives

- Understand general navigation features of
the QAD .NET Ul

« Know how to use the Workspace menus

+ Understand navigation differences in
different types of programs

MQAD
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Benefits

Chapter Benefits

« You willbe able 1o navigate the different
types of screens and programs within
Enterprise Applications

MNQAD
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Training Flow

Training Flow

* Introduction

- Navigation

» Application Help
- Programs

- Browses

» Character Ul

- Dashboards

MQAD
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Overview of Ul Navigation Features

Ul Navigation Features

Main menu bar

| Applications L=
’ e Menu search for programs,
#13 Callections browses, and other menu items

# 7y Metrics

+ {3 Customer Management

#-(3 Supply Chain 3 ,

% £ Memiocturing o «—— Applications Ared
% = Financials

#43 Master Data

#1075 System Administration

+ ) Processes
# () Administration

File Edit Tools Workspace Window Help

047 Hide and View MNavigation Pane

e «—— Favaortes Ared
B Browse Collection Mainwnance
%5 Menu Collection Maintenance

# i3 Process Sales Orders

[ Quick Search o
= Messages o
2 e

2

inbox
Sant
Drafs.

Quick Search Ared

Messages Inbox

mig -

The QAD .NET User Interface (UI) provides acommon framework for multiple QAD
applications. This framework, based on Microsoft .NET technology, has excellent performance
and provides best-practice usability and deployment features, as well as extensive ways for users
to adapt the Ul to their preferred work style.

When you first log into the .NET Ul, you see a screen like the one above.

1 Themain menu bar includes selections for File, Edit, Tools, Workspace, Window, and Help.
2 The menu search helps you locate programs to run.

3 The Application area displays the application programs that can be run in the QAD .NET UI.

4 Usethe dashed bar to close and open the navigation pane. Closing the pane gives you more
areatowork in.

5 The Favorites area can be customized by each user to list frequently used programs.

6 The Quick Search arealetsyou search for avalue across all of the fieldsin a browse group,
which are definable by each user (see “ Quick Search” on page 103 for details).

7 The Messages inbox displays messages generated through the QAD Enterprise Applications
internal mail system.

Each distinct area of the Ul can be resized to suit your needs by dragging the edge to the place you
want.

MNQAD
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Workspace

Workspace
File Edit Iool{ W[ Window Help

& Applications TsA Division [USD] > 10CORPCONS USA CORP. CONSOLIDATION
1 1] 10USA\USA Division [USD] > 10USACO USA DIVISION

%711 SslesOf | 11CAN Cynada Division [CAD] > 11CANCO CANADA DIVISION

Ern SalesOr | 11CAN Cartgda Division [CAD] > 11NACONS N.AMERICA CONSOLIDATION

B2 Seleso N
57113 Sseso] | 12MEXMexicy Division [MXN] > 12MEXCO MEXICO DIVISION

(37114 Sales Or 20FRA France Djvision [EUR] > 20FRACO FRANCE DIVISION
5;1:2 mg 21NL Netherlanda Division [EUR] > 21ITCO ITALIAN DIVISION
I="FARY] Sales Or 21NL Netherlands Djvision [EUR] > 2 INLCO NETHERLANDS DIVISION
:71 18 Complet 22UK United KingdomyDivision [GBP] > 22EMEACONS EMEA CONSOLIDATION
L’j;l }3; ﬂ,’: g 22UK United Kingdom Division [GBP] > 22UKCO UK DIVISION
. 30CHN china Division [ > 30CHNCO CHINA DIVISION
31AUS Australia Division [ADD] > 21APCONS ASIA-PAC CONSOLIDATION
%1, Containerize Sald 314US Australia Division [AUDY, > 31AUSCO AUSTRALIA DIVISION
# luz| Process Sales O QAD System Domain [USD] > 99¢ - SYSADM

& Vertical Industy | 11 puyerto Rica - Demo [USD] > Kntity € SSM Training Entity
F Quick Search Train Puerto Rico - Demo [USD] > Trajning Entity For Training

1 Favorites
1 iz Set Up General

Starts With v | B

# ¢ Customer Data
Click to select a workspace
from the menu or the
workspace selector toolbar

essages oo -
OUSATISE Division [USD] CAN Canada Division [CAD] TCAN Canada Drvision [CAD) MEX Mexico Division [MXN
R X 8] DA D 0

Inthe .NET UlI, your application context is determined by a combination of domain and entity,
called aworkspace. Workspaces represent the area of your business where you are working. Inthis
class, you are using the 10USA > 10USA CO workspace, which represents the 10USA domain and
the 10USACO entity.

Most users only use one workspace and once selected, it is always active by default. When you
exit the QAD NET UlI, the active workspace is saved and displays when you log in again.

If needed—and you have the necessary access—you can select a different workspace that displays
on the Workspace menu. The check mark signifies the domain that is currently active.

If you need to change workspaces regularly, you can also enable the workspace toolbar, shown
above. Clicking aworkspace name in the toolbar changes the current domain and entity. The
toolbar is enabled using the Show Workspace Selector option on the Tool s|Options menu.

For information on the domain and entity concepts, see Training Guide: QAD Quick Sart.
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Ul Navigation: Process Maps

Ul Navigation: Process Maps

+ Link multiple actions to a single node

& +Link to any document type
e i « Navigate to dppropriate functionality
b i wzo-|  +Standardize training
B2 B (G )@= | ~Reduce errors
[ v- . - | & * Deploy globally in multiple languages

Process Sales Orders

e +
Enter Sales Run Credit Update Sales
Order Report Order Credit
Sales Ordar
i Sales Order Generate EMT
Aceountin 9 it R » i CR
F
2 b
Sales and Order Orler
Marketing e O e b codRimed < EMT Supober
W
instricions importerso | ERERCNE,

The .NET Ul provides many ways to navigate and find programs you are interested in. You can
select programs from the menu on the left or enter a program name or number the search field.
These methods are shown in following slides.

This slide shows a top-level view of the process maps supplied with the .NET Ul. These maps are
graphic representations of workflows that can include links to programs, browses, documentation,
URLSs, or other maps.

The .NET Ul includes a Process Editor so that administrators can create their own maps that
accommodate unique company standards. Users can edit process maps for any segment of the
organization, or model unique environments in as much detail as appropriate.

The set of process maps supplied with the product has been carefully designed to incorporate best
practice workflows tailored for various vertical industries.
Using process maps can:

- Improve end user performance by making process instructions visual and readily available,
increasing awareness of standard procedures for routine and special tasks.

« Reduce errors and waste since users quickly access information regarding handling
procedures, detailed documentation and instructions, eliminating guesswork.

- Increase global staff communication through maps that are globally available and editable to
match regional language and operational demands.

MNQAD
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Drill-Down and Breadcrumbs

Drill-Down and Breadcrumbs

Supply Chain Process Model » Select Global Suppliers » Schedule Purchase Orders

Schedule Purchase Orders

Planning and
Scheduling Purchasing

/  Supplier
= b Schpegil\de
= | Update
_Piace Purchase J Place Purchase
isition Yes X

| Manage Discrete,
W, Purchasing |

4

Processes are built with two basic components:

- Nodes are represented by various shapes and typically indicate a step within the process.
« Connectors are lines with arrows that indicate the direction of execution for the steps (nodes)

within the process.

You navigate the process map using nodes, and can retrace your steps using the hyperlinked

breadcrumbs at the top of the screen.

MQAD
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Ul Navigation: Applications Area

File Edit Tools Workspace Windg

@} Applications

T Collections

+{ 5 Customer Management
T Supply Chain
[T Manufacturing

+{5 Financials

#5 Master Data

FHCT System Administration
¥ 7] Processes

T Administration

.7 Favorites
Iliél Set Up General Ledger
Containerize Sales Order Shipments
e Ill:El Process Sales Orders

&% Vertical Industry View
[+ mg My Collection

{51 New Folder

Enter menu Nname of —s
rumber fo open

Click folder or + icon —»
to open

Double click any —s
program fo open

File Edit Tools Workspace Window
@Applicatinns

Search

E {5 Collections
T Metrics
= * Customer Management
EH.* Sales Orders/Invoices
[ "* Sales Order Menu
%Y Sales Order Maintena
[ Sales Order Browse
EI Sales Order Print
|EE| Sales Order Viewer
5 |;| Sales Order Confirmation
EI Sales Order Manual Allocations

F Favorites
4 |&| Set Up General Ledger
Caontainerize Sales Order Shipments
FHUE| Process Sales Orders

£ Vertical Industry View
{5 My Collection

{5 New Folder

Help

The Applications area displays the menu items for the QAD applications running in the
QAD .NET Ul. When the system is installed, the default menu organization is automatically
loaded. Multiple screens can be open at any one time.

You can use the mouse to select menu items. You can use the menu search to:

 Find programs based on one or more menu label keywords, program name, or menu number.
For example, enter sales to display all menu labels that include the word sales.

- Execute a specific program based on full menu label, program name, or menu number. For

example, enter Item Master Maintenance, ppptmt.p, or 1.4.1 and then press Enter to display
Item Master Maintenance.

« Execute a specific program based on a shortcut defined in the Name field of Menu System
Maintenance (36.4.4.1in EE, 36.4.4in SE).

When typing in the menu search area, different screens appear as the typing continues until the
proper screen islocated. Thisis called predictive text.

MNQAD
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Menu Properties

Menvu Properties

File Edit Tools Workspace Window Help

711 *
(S AK] Salss Oider Mantenance
Ei Fin Sales Order Repricing | 4 Find in Menu
27112 Sales Order Cost Revalu L_g Add Ta Favarites
"; 7113 Sales Order Credit Maint: Onen,
Ié 7.1.14 Sales Order Credit Inquin P
@715 Sales Order Credit Hepor| Design
= [EARI Sales Order Auto Credit I-l Properties I
B 717 Sales Order Auto Credit Appre v

G 7118 Frrerlatad Galas Midar Malats 1))
| | ¢

Favorites

S Sales Order Maintenance
% Purchase Order Maintenance

You can view the information about a menu item by right-clicking it and choosing Properties from

Right-click any
program and
select Properties

the pull-down menu. The Properties window includes two tabs: General and Program.

The other options on the right-click menu let you:
» Find the program in the menu system, so you can see its hierarchical position relative to other

programs.

Note The Findin Menu option changesto Collapse Menu when the hierarchy is already

displayed.

» Add the program to the Favorites area (you can a so do this by dragging).

» Open the program in the workspace so you can useit.

» Design acustom version of the program. This option is disabled unless you belong to a special
group of users with access to the Configurable Screens feature. Configuring custom program

screens is an administrative function that is covered in Training Guide: QAD .NET Ul

Administration.

MQAD
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Properties Options

Properties Options

% Sales Order Maintenance Properties =)
bR L — r -
%, Sales Order Maintenance Properties =5

General || Program |

Sales Order Maintenance

Domain:  USA Division (USD)
URL:  gadshiimenuinvoke?menu-key=A 1Amenuitem-key=7 11
Program: sosomip

Key: 711
UI Template:

Aliases: 711, sosomtp
Desktop Version: 2.10.35.130
Menu: Customer Management
Version: QAD Enterprise Applications 2012 - Enterprise Edition

Open with: |Deskiop -

oK .l - (am' lr __7

\ |
|

[ oK { Cancel ][ Apply ]|

The General tab displays:
URL. The QAD Shell URL for the program.

Key. The program number; 7.1.1 is the program number for Sales Order Maintenance.

Aliases. The program number and name. For example, for Sales Order Maintenance, 7.1.1is
the program number and sosomt .p isthe program name.

Menu. The menu item folder location.
The Program tab displays.

Domain. The current working domain and domain currency. If the specific program updates
datathat appliesto al domains, All Domains displays.

Program. The program name. For example, sosomt .p isthe program name for Sales Order
Maintenance.

Ul Template. If the user executing the program has been assigned a Configurable Screens
version of the program, the name of the assigned Ul template displays. The configurable
screens feature is discussed in Training Guide: .NET Ul Administration.

Desktop Version. Version details for the .NET UI.

Version. Product system version details.
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Properties Options: Open With

Properties Options: Open With

o . : B Lnes Tisker
5 Product Structure m.mm g < e
[l e— S S s o b
General | Program D 1060 ok pox Lnfe S -
i O L
Domain ¢ USADivision (USD) L st - LaiPrce Dicanrt it Free
» m oo wm
Program: bmpsmip
Ul Template: .
o sk
Desktop Version: 21085130 Donc: Samdim Coclrt e
Lee || e Mech
H Version: QAD Enterprise Applications 2013 =0 ot am ATt
Lo S Ty
Gy ocnt M Coremrin oo
Open with: |Desktop Oy Pickadt Cormuns Feat
_NET User Interface ] O Sheve ey
Deskiop
| [Terminal
.....................
| . - =
1 ip-m
H o | carcel | [ Appy
—— =
He

Open with. Determines how the program will display in the workspace. Possible values are:

Desktop: The mode normally used by non-component programs in the .NET Ul, which
supports al of the enhanced navigation features.

.NET User Interface: This mode is supported by only afew programsthat have been rewritten
using a client-side plug-in that supports additional navigation features such as drag and drop.

Browse Viewer: Thisisthe normal mode for browses that displays datain an interactive grid
or chart format.

Terminal: This mode is a simple representation of a character-based screen.

You can change the Open with property from Desktop or Browse Viewer to Terminal according to
your preference. If you do so, your choice will be retained from session to session.

Note You cannot change the Open with setting for component-based programs.

This slide shows Sales Order Maintenance asit displaysin the QAD .NET Ul (Desktop mode) and
the moretraditional Terminal version of the screen below. In Desktop mode, you can use point and
click, tab, Next, Back or Header, Lines, and Trailer Tab to navigate.
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Favorites
-
Favorites
5 S Ot E Right-click a program and select
e Add to Favorites, or drag and drop
D Sales Drd-erF ._a]a Add To Favorites .
5 Soes e\ Collpae Menus programs to the Favorites area
@ Sales Order
] Ssles Orger Qpen
5| Seles Order 4 Design
[ | Propetis
e > T Programs that are used frequently
i e el L s so that a search is notrequired
Er CU1500 Browse |
S Entity Create
.7 Favorites
[+ |[g, Set Up General Ledger
FEf CU1500 Browse
qug Gnd drop r‘sEntlt','Create ] j
= | Rename
ex-l-ernql 'I:Iles _—» E_] Sales\'\c'orklnstrucllc - . .
" Additional right-click
and programs " e options for Favorites
into Favorites ‘C‘; S““; P
Ol EpSE enus
Open
Design
Properties

The .NET Ul letsyou customize the interface in many ways to make your work easier. Oneway to
do thisisto set up your own personal favorites menu. You can do thisin two ways:

« Right-click aprogramin the top list and select Add to Favorites.
 Use your mouse to drag the program to the area below. This makes a copy of the menu item;
you can still find it in the list above as well.

Remove an item from the favorites using the same steps. either right-click and select Remove or
drag out of the Favorites.

You can rename programs in your favorites so they are even more personalized. In addition, you
can create folders and subfolders for organizing favorites by right-clicking in the Favorites area.

Two other options |et you further manage favorites. You can:

« Select one or moreitemsto start automatically when you log in using the Auto Start option. So
if, for example, you typically log into the system to approve requisitions, you can have the
Purchase Requisition Approval program start automatically every timeyou log in. ltems
selected for Auto Start display in bold text in the menu.

« You can change the icon associated with a program by loading the image you want to use.

One other useful feature for favorites is that you can add external files by simply dragging and
dropping them into the favorites area. This slide shows a Microsoft Word file with work
instructions added as a favorite.
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Workspace Menus

Workspace Menus

- File Menu
Edit Menu
Tools Menu
Window Menu
Help Menu

The menus on the menu bar of the .NET Ul workspace provide many useful options, discussed
next.
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File Menu

File Menu

File  Edit Tools ‘Workspace ‘Window Help
Logoff

;:j‘g Fage Setup
= Print Preview

= Frint Cirl+P

1 USA USA-Demo [USD] » USA-01 USA Primary Entity f Home Page
2 24D Systerm Domain [USD] > 994 - 8Y5ADM [ Home Page

Exit

The File menu commands include:

Logoff/Login. Log off from all applications running in the QAD NET Ul. You canloginasa
different user if security allows.

Page Setup. Defines print output for browses; this has no impact on maintenance programs.
Print Preview. Generates a print preview of a browse prior to print.

Print. Open the print dialog so that you can print the data for a browse or the screen for other
programs.

Program History. The section below Print displaysthe last six programs that you have opened.
You can choose to open one of these programs directly from this pull-down menu.

Exit. Close the QAD .NET Ul and log off any open applications.
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Edit Menu

Edit Menu

File gd'ﬂ Tools Workspace Window Help
X ut |

Ctri+X &
®13|43 copy Ctrl+C
B 1 %y Paste Ctri+V
+| « Menu Search Ctrl+M
-] Servicersupport
() Customer Management Roles

=1 "% Supply Chain

The Edit menu commands include:

Cut, Copy, and Paste. These are standard Microsoft commands. View associated shortcuts on
the screen above.

Menu Search. While in any screen you can immediately go to menu search by using the
shortcut Ctrl+M or select Menu Search from the Edit menu.
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Tools Menu

Tools Menu

File Edit Iools| Workspace Window Help

£38 ) Collect1 Options... g
+-{(J) Metrics Internet Properties
=% Custon :

263 Sal s} Delete History

#) Cor Manage Workspaces
IR SenvicerSUpport

+-7) Customer Management Roles

“¥ Supply Chain

+ ) Warehousing

The Tools menu commands include:

Options. View administrative information and set personal options for browses and other
application settings. For more information, see next slide. Settings the user cannot configure
are viewable from Help| View Configuration.

Internet Properties. Update the same settings that display when you select Internet Options
from the Tools menu in Internet Explorer.

Delete History. Delete the following data:

- Temporary files: Internet Explorer cache and |E cookies and cached resources created for
the current configuration.

» Session information: the graphical state stored by the GUI persistence manager. Also
deletes user input, such as last configuration, last workspace, most recently used menu
items, and credentials.

Manage Workspaces. Activate and deactivate workspaces from alist and reorder them.
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Tools | Options

Tools | Options

rn Options __d 1 lﬂlﬂlﬂ
El Browse ~|
Cancel transaction on drill change True A
Cell Font Microsoft Sans Serif, 8.25pt
Link Font Colar I clue
Row Alternating Color I:| 235,235, 235
Row Background Color ] white L
Rows Per Page 100 3
Side Panel Auto Cpen True
El Browse Maintenance
Show Index Information True
E Desktop I |
Auto advance on the last data field False |
Cell Font Microsoft Sans Serif, §.25pt
Message Color M slack
Message Font Microsoft Sans Serif, 12pt
Prompt user on open transaction True
Screen Mavigation Bar True
'Text' Report Font Lucida Console, 8.25pt
UI Extensions True
El General
Allow Multiple Applications True E|

ol Left Navigation Panel Style Studio Toolbox -

Allow Multiple Applications
If this value is set to true, then multiple instances of the application can be launched.

1%

QAD .NET Ul lets each user configure many different settings that affect the Ul in these areas:

Browse. Configure settings for Cancel transaction on drill change, Cell Font, Link Font Color,
Row Alternating Color, Row Background Color, Rows Per Page, Side Panel Auto Open.

Desktop. Configure settings for Auto advance on next data field, Cell Font, Prompt user on
open transaction, Screen Navigation Bar, Text Report Font, Ul Extensions.

General. Configure settings for Allow Multiple Applications, Left Navigation Panel Style,
Show Workspace Selector.

Guide Me. Enabled.
Home Page. Enable Home Page, Home Page URL.

Messaging. Configure settings for Auto Complete Recipients Textbox, Display Alerts, Empty
Deleted Folder Frequency, Poller Frequency.

Metrics. Image, Title.

Terminal. Background Color, Bold Color, Font, Foreground Color.
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Window Menu

Window Menu

File Edit Tools Workspace ﬁindow] Help
& Applicaions } Close All Windows T —
ari v I r Mai n '

' supplier in |v| 1Sales Order Maintenance e & P
%y Supplier Invoice Activity View 2 Sales Order Repricing g
“rb}&ppierhvﬁce Mocate 3 Supplier Invoice - Supplier Invoice Activity
%Stppierhvmﬁpwove = JData D> Saled
% Supplier Invoice Browse Drafts Header
% Supplier Invoice Control - ]

: 35 T
% Supplier Invoice Create Order:| S| Sold-To:
% Supplier Invoice Delete
;{;}&.ppierhvon‘oe&dmded\ﬁew Sold-To
*{5 Supplier Invoice Initial Create

This menu displays a history list of programsin the order in which they were opened. Selecting
Close All Windows shuts all screens on the workspace.
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Help Menu

Help Menu

File Edit Tools Workspace Window |Help|

@ Applications h 4| « Search

’7.1.1 X @ Application Help Copy ~| & Print & Preview
G711 Sales Order Maintenance » View Configuration -

B711 Sales Order Repricing SedE R o
=7.1.12 Sales Order Cost Revaluation SR kinfo > FreightData D Saleq]
7113 Sales Order Credit Maintena... About

L,_JTJ.M Sales Order Credit Inquiry - )

37115 Sales Order Credit Report Order: Sold-To:

ﬂd -4 4 ool . | A o Sa 044l

Use the Help menu to display Application and Program Help, and to view installation and
application configuration details. Help is discussed in more detail in Chapter 3, “Help in the
QAD .NET UI,” on page 47.

The Help menu commands include:

Search. This option displays the default search page.

Application Help. This option is available when your cursor is placed within a non-component
based field or screen. When you then select Application Help, field or procedure help is
displayed for the field or screen.

View Configuration. Opens awindow that displays various configuration settings that cannot
be directly changed by a user of the QAD .NET UI. These settings must be changed by a
system administrator.

Send Error Report. Use this option to save or send an error report. You can view the report,
which includes QAD .NET Ul configuration information and log files and enter additional
information about what you were doing when the problem happened. Optionally, you can
enter your e-mail address and send a screen shot and either Send or Save.

About. Displays information about the version of QAD .NET Ul that is running, the time the
QAD .NET Ul was started, and the total amount of physical memory the QAD .NET Ul is
using. (If N/A isdisplayed, the operating system is not giving the QAD .NET Ul permission to
access system information.)
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Component and Non-Component Based Programs
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Component and Non-Component Based Programs

Enterprise Financials and System
Administration orograms only

= Purchsss Ovder Retums %

W GoTo = ¢« Adons =| b Copr =| 5 Print
Purchate Order bom 1

3 Provaw | & Ansch

Purchase Didec | from £ Suppler Seatur

ATV Nk
SherFiom
ShoTo

Only Enterprise Edition Financials and some System Administration programs are component-
based. All other applications are non-component based, including Standard Edition Financials.

Component-based programs have individual maintenance programs, such as Create, M odify, and

Delete.

Chapter 4, “Programsin the QAD .NET Ul,” on page 59 provides details about using programs.

MNQAD



40  Training Guide — QAD .NET Ul

Navigating Component-Based Screens

Navigating Component-Based Screens

J Journal Entry Create
# GoTo - Actions * ¥ Tools "! & Atach ! (= Print o Preview
Attachments ®
Year [2oma|[ o5 | Posting Date [os/05/200 |
Daybook Code | s\ e | 000000000 | L Twr l ,l Save As Template
Description | Template Code I # I Replacement
Dn?mal Posting | e i by | mmm|
©  Relerence L | wence M 100000000
GL Account 4 GL Description 4 Sub-AccountC ¢ CostCe o Description ¥ Trans % TC Debit L3 TC Credit +  Intercompany Code
»
el I ] L]
Currency View :_Transa_ctin_n Currency = | Total TC | D.DD!! 0.00]
[ Save and Create H Save ][ Close

Because the component-based Ul is based on Microsoft .NET technology, it incorporates familiar
mouse, click and drag, and tabbing functions.
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Horizontal and Vertical Tab Groups

Horizontal and Verical Tab Groups
!Sa\es Order Maintenanrce I!Iem Master Maintenance "-'l
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You can choose two ways of viewing multiple screens in the application area. Thisworks
especially well with the QAD .NET Ul browse programs.

This dlide shows the Process Sales Order menu collection, which groups all of the programs that
you might need to use to compl ete activities related to an order. The grouping is facilitated by
defining tab groups. Right-clicking the Process Sales Order tab displays the menu in this slide.

Tab groupings help you organize open programs in either horizontal or vertical layout.

» Click New Horizontal Tab Group to split the screen horizontally and move this program to the
new area.

» Click New Vertical Tab Group to split the screen vertically and move this program to the new
vertical area.

You can only use horizontal or vertical groups, not both. But you can create as many of one type of
group as you want.

You can also detach atab from the application areaand display it in anew window. Right-click the
tab and choose Move Tab to New Window or enter Ctrl+F11. To move atab in a separate window
back to atab in the application area, enter Ctrl+F11.
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Navigating Non-Component Based Programs

Navigating Non-Component Based Programs
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Because non-component based screens are a rendering of the character Ul, you can navigate these
screens using the same keyboard commands. You can also use mouse clicks to select fields and
enter data.

When some programs open in Desktop mode, a navigation bar is displayed along the top of the
screen indicating where you are as you proceed through the program screens. Not all programs
have this bar; it is typically used with complex transactions such as order creation.

For example, the screen for Sales Order Maintenance includes anavigation bar indicating the parts
of asalesorder: Header, Lines, Trailer. Within each major section, you can navigate using the bar
to specific subareas. When you are displaying the header of a sales order, you can navigate directly
to Details, Tax Info, Freight Info, Salesperson, Delivery, Consignment, or Comments by clicking
the label in the navigation bar.

The Screen Navigation Bar option in the Desktop section of the Options menu (choose Tools|
Options) controls whether your QAD .NET Ul client displays the navigation tool.
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Navigating Lookup Browses

43

Navigating Lookup Browses

Sales Order Maintenance
= GoTo v Actions »| L1l Copy =| =0 Print (& Preview | & attach
Salas Order: & Order
Header Lines
> Header > [0 [ 2 f > Fre [ 2 [ 2 [ B
Header
Oider; Sold-Ta: Bill Te: Ship-Ta:
| WSales Order Master
Seld-To . = ”
x Actions = =) Print
earch
[5ales Drder - | [starte at - Pla] -
Records per page: 100 - ® @
Sales Order A% SoldTe &% OrderDate & % Purchase Order
[l 10005 CE4000 0&/21 /2007
Details 10006 CE4000 06/21/2007
Orclat Date: 10009 CE4000 0&/21,/2007
. 10012 CE3000 0E/21/2007
Flequired Date:
b o 10013 ce3000 OE/21/2007
i be:
et 10016 CE3000 06/21/2007
Dug Data: 10019 CEA000 06/21/2007
Ferform D ate: 10025, CE3n00 (R42242007

Many fields display a small magnifying glassicon on theright of the input area. Thisindicates that
alookup is associated with the field. Click theicon or use the Alt+L keyboard shortcut to display

the lookup. The lookup lists valid values for the field.

A drop-down list is displayed when only afew values apply to afield.

Browses on the menu, called power browses, include more complex navigation features. Browses
are discussed in more detail in Chapter 5, “Browses in the QAD .NET Ul,” on page 81.
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Summary

Summary

« NET Ul has many alternate ways of
navigating

« You can choose the mode of display for a
program

« Differences exist between component-
based and non-component based
programs
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Exercise and Knowledge Check

These exercises and discussion questions will help you become familiar with navigating the user
interface.

1 Using each of the Process maps (Vertical Industry, End-to-End, and Supply Chain), drill down
until you can create a sales order. Which view seemed easiest to you?

2 Create a custom menu by:
a Right-clicking amenu item and selecting Add to Favorites.
b  Drag several menu items into the Favorites section of the UI.

3 Open thefollowing four programs:
 Sales Order Maintenance
« Sales Order Shipments
 Sales Order Browse
 Sales Order Credit Browse

Right-click on Sales Order Browse and create a new tab group. Add Sales Order Credit
Browse to the tab group with the other browse. Can you see how this arrangement could help
you when processing a sales order?

Right-click on Sales Order Browse again and select Close All.
4 Change the way a program displays:

a Select Customer Data Maintenance from the menu.

b Right-click and select Properties.

¢ Onthe General tab, note the menu number associated with this program. What isthisfield
labeled?

d Click the Program tab and change Display with to Terminal. Click OK.
e Typethe menu number (2.1.1) in the search and press Enter.

f  Compare the two program displays by selecting a customer record and moving through the
frames. How isthis Ul different than the normal Desktop mode?
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Objective

Objective

- Learn about the extensive help capabilities
of the QAD .NET Ul:

Character Ul Help

Application Help (F1 or Help | Application Help)

QAD Search (Help | Search)

- QAD Guide Me

QAD Document Library
http://www.gad.com/documentlibrary/

1

1
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Benefits

Benefits
« Become aware of the different types of help
and how they can be accessed

+ Be able to choose the most appropriate
help source
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Training Flow

Training Flow

« Introduction

+ Navigation

- Application Help
- Programs

- Browses

« Character Ul

- Dashboards
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Help in Terminal Mode

Purchaie Quder Maintenance % ‘

| Purchase Order:

Supplier:

Supplier

|

Ship-To:
Purchase Order Maintenance ¥
Pur Enter a number identifying an order or leave blank for

Purchase Order iyl

Purchase Order

Order Date:
Due Date:
Buyer:

Bill To:

123
20010601
akbd
acmel

ascl00

Sales/Jobk:
Contract:
Contact:
Remarks:

fin

Enter data or press F4 to end.

system-generated number. If blank, the system creates

number baged on the purchase order prefix and next pur

order number maintained in Purchasing Control.

The system displays a warning if:

o You enter a

purchase order that has already been p

1f you modify the order, it may no longer correspol

the one sent to the supplier. You can update the r

number to track additional changes.

0 The order you specify was created in Scheduled Ord

Maintenance.

Since different data is maintained fo

scheduled or

ders, you should normally maintain thes

their own pr

ogram.

Enter data or press F4 to end.

Access help in terminal mode by pressing F2.

 Thefirst timeyou press F2, alookup browse displaysif oneis attached. If not, field help
displaysfirst. Use lookup browses to view records available to specified fields. You can
choose arecord to enter in thefield. If you enter avalue and press Enter, the list in the bottom
of the browse frame scrolls to the first record that matches that value. Use the arrow keysto
scroll through the list, then select the record by pressing Enter.

» Press F2 again to display field help. It describes a specific field and how it isused in the
program. Most updateable fields have field help. Display-only fields do not.

» Press F2 again to display procedure help. It describes the program and how it is used in the
module. Procedure help is not generally provided for reports, inquiries, browses, or control

programs.
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Help Menu

Help Menu

File Edit Tools Workspace Window |Help
&} Applications |:';JPTC‘=' + Search |‘\<‘

| Menw Search i @ Application Help

= M Go e sl ‘g,: Print ] Preview
[#-{7) Collections View Configuration
+-] Metrics b
> Send Error Report b I
[#7) Customer Management He S »
{CT Supply Chain About

[#- Manufacturing T T o .‘-‘! Sold-To
[+ Financials
'+ i) Master Data
System Administration Sold-To
Processes
) Administration
'+ i3 Tools

[+

Options on the Help menu include:

Search displays a panel where you can search field or program help or both using terms and
operators.

Application Help is available when your cursor isin afield. Choosing it displays the relevant
field or program help. You can display the same information by pressing the F1 key.

View Configuration opens awindow that displays various configuration settings that cannot
be directly changed. This information can by useful for system diagnostics.

Send Error Report lets you save or send an error report that includes QAD .NET Ul
configuration information and log files. You can enter additional information about what you
were doing when the problem happened. Optionally, you can enter your e-mail address and
send a screen shot.

About displays information about the version of QAD .NET Ul that is running, the time the
session was started, and the total amount of physical memory being used.
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Application Help (F1) for Programs and Fields

Application Help (F1) for Programs and Fields

QOR2D D
" BIournalEntry.Create |' Field Help | =
Journal Entry Create Al
Use Journal Entry Create (25.13.1.1) to manually record transactions for financial daybooks.
However,. "
e : ol
A journal entry, or postin @ Help g@

representation, a journal (| 5y 5y ® -'n "-5'# s
associated with a GL accoll — —
have other dimensions, re

r.. Sales Order Maintenance | Field Help \|

Define the transaction po{| | 53les Order | Sales Order
levels containing addition|| g0 gb-account . ber identifyi 3 | S

: nter a number identifying an order or leave blank for a system-

The level 1 posting line cq  Salesperson generated number. If blank, the system creates a number based on the

description, base currency|  Selected sales order prefix and next sales order number maintained in Sales Order
; ; Ship Via Control.
The posting grid can auto| !p i
on how the GL accounts 4| ShiP-To
Site (so_site)
o Transaction currency Site (sod_site)
[<] Sold-To
Sort Name
Standard Bill =]

Standard Pack
Quantity
{ord_mult_alt)

Srandard Dark Inel

The number uniquely identifies a specific order or pending invoice and its
line items.

QAD Document Library | Support

When your cursor isin aprogram field, you can press F1 or choose Help | Application Help to
display online help. Help is organized into two tabs:

» TheField Help tab displays alist of fields associated with the current program. Help for the
field where you cursor islocated initially displaysin the help panel.

» The other tab displays the name of the program and the associated help information.

At the bottom of the help panel, you can access links to the QAD Document Library or to QAD
Support, which includes an extensive knowledgebase.
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QAD Guide Me

QAD Guide Me

‘ Item Master Maintenance X

% GoTo - Actions - | L Copy -| (=) Print & Preview | # Attach -
ltem Planning Price
b Hem P ltemData B Inventory B ltem Shipping Data
ltem
Item Number _[ pel Description:

Unit of Measure:

ltem Data
Prod Line: [tem Tyr,}: Drawing:
Added: <t; Enter an optional code used to categorize similar items.
This field is validated against predefined values entered in
Design Group: Gr Generalized Codes Maintenance for field pt_part type, if Size:
any. More...
Promo Group:
Edit
Item Imventory Data
ABC Class: Average Interval:
kliSesizl Conizol CxaleCountlntenal,

The QAD Guide Me feature provides immediate mouse-over descriptions of fields in both
component and non-component programs.

Note If thishelp does not display, it may be disabled. You can enable it using the Guide Me
setting found on the Tool s|Options menu.

One useful feature of this help isthat you do not need to locate your cursor in afield to see the
help. In the current example the help for Item Typeis being displayed even though the active
context field is Item Number.

Click the More... link to display an extended description of the field, and the Edit link to edit this
description in Field Help Maintenance.

Note The Edit option displays only if your role gives you access to this program.
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Search

programs,
fields, or both

Use achvanced
search operators
and fuzzy
matches

QAD Search

Pragram Help | Field Help | Al

Customer AND Create

Customer Payment Create [BDDocument.Create]
Use Customer Payment Create (27.6.4.1) to create customer payments,

Customer Ship-To Create [BDebtorShipTo.Create]
Use Customer Ship-To Create (27.20.2.1) to create customer ship-to records,

Customer Create [BDebtor.Create]
Use Customer Create {(27.20.1.1) to set up customer records in the system.

Customer Type Create [BDebtorType.Create]

Usge Customer Type Create (27.20.4.1) to create codes for grouping customers. You can use
customer type to select groups of customers for reporting, in particular for sales analysis
reports. Customer types are system-wide data and apply to all domains and entities.

Customer Invoice Create [BDInvoice.Create]

Use Customer Invoice Create (27.1.1.1) to directly create invoices for miscellaneous customer
charges or credit notes. For this type of manual invoice, you must specify most of the fields
that are automatically populated during invoice post.

Choose Help | Search to display the QAD Search panel. You can do simple searches for single
terms such as Sales and phrases such as Sales Orders. You can also create more complex terms
using operators such as Sales AND Region. You can use any of the following operators (entered in

upper case):

AND, +, OR, NOT, -

If you are unsure of the exact term you are searching for, use wild cards:
» Use aquestion mark (?) to replace asingle character; for example, S?les
» Use an asterisk (*) to replace multiple characters; for example St*es

» Usethetilde symbol (~) to perform fuzzy searches, which return results similar to the term
you entered. You can specify the similarity to the searched term using a numerical option
between 0 and 1 for example, sales~0.8. The closer the value to 1, the greater the similarity.

The default value is 0.5.

» Use numeralsto specify words within a specified distance from each other. For example, if
you enter Sales Region~10, the panel displays all instances of Sales and Region that appear
within 10 words of each other in a document.
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QAD Document Library

QAD Document Library

O Help W =)

- -

QEeRLSS D

Search ccross cll

- e documentation m—
QI resourcss -

Tips on Using the QAD Document Library |

The Document Libeary contains online and PDF documentation for all QAD products. To
leam more, see QADL eni Library Overvie

O

How to Find Content

Use
ncvigation to
find a bbook

= =W

Tl_. w F F- [ E- p L3 b & & lO oﬂ [GRCEGE _‘-

1. Use the Havigation Tree on the left, which ksts content grouped by QAD
application and book type.

2 Usethe Search, which finds all documents with your search terms and lets you
refine the search by book type, product sulle or medule, and date publshed

What Can | Do with the Content?

Dnce you find the conlent you want, you can choose icons on upper right of page as
shawn below.

Stant by logging in 1o rate, add comments  °;*
Print current page B Fril Page
Downicad book as POF | 55 Downliaad Book
Show archwved versions of current book Bl #7chved Versans

Link to related forum [ Manufacturng

m ’

Access the QAD Document Library by clicking the link at the bottom of the application help or
search panel. The library includes user guides, administration guides, installation guides, training
guides, and other materials.

You can also access this library directly from your browser:
http://www.qgad.com/documentlibrary

From the Document Library, you can:

- Usethe navigation tree on the left, which lists content grouped by QAD application and book
type.

+ Use the Search, which finds al documents with your search terms and lets you refine the
search by book type, product suite or module, and date published.
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Summary

Chapter Summary

Help includes the following features:
- Character Ul Help

- Application Help (F1)

- QAD Guide Me

- QAD Search

- QAD Document Library
http://www.gad.com/documentlibrary/
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Exercise and Knowledge Check

1

Launch Purchase Order Maintenance in Terminal mode.

Note Use Properties, Open with to change the mode to Terminal if needed.

Press F2 in thefirst field of the purchase order. What is displayed? Press F2 again. What is
displayed thistime?

Go to the Sales Order Maintenance screen and select Help | Search. What screen is displayed?
Do a search on the word Sales. Drill down on Sales analysis. What is displayed?

Go to Journal Entry Create and press F1. What is displayed? Note the differences between
non-component based help and component-based help.
Find out the answer to the following question by using one of the forms of online assistance:

When a sales order is created, a default value displays for Credit Terms. Where is this default
value set?

Which form of help did you use to find the answer? Why?
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Objective

Chapter Objectives

« Describe program types and program
features in QAD Enterprise Applications
« Review program menus

+ Infroduce QAD Messaging
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Benefits

Benefits

« |dentify different program types
« Understand how to use program menus
+ Use QAD Messaging effectively
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Training Flow

Training Flow

« Introduction

+ Navigation

+ Application Help
- Programs

+ Browses

« Character Ul

« Dashboards
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.NET Ul Program Types

oNET UI Program Types File Edit Tools Workspace Window Help

@ Applications

) Collections (3
#-{7 Metrics
=} "% Customer Management
=1, ™* Sales Orders/Invoices
=1 "* Sales Order Menu ‘
% Sales Order Maintenance
Browse @——. [y Sales Order Browse
= [@ Sales Order Print
Trarnsacton or Utility ‘-2 | (2] Sales Order Viewer
—— = Sales Order Confirmation
|=| Sales Order Manual Allocations
: |=] Sales Order Auto Allocations
Report or Inquiry _@____. @ Avalable Kit Quaniity o Sip
|=| Sales Order Repricing

; |Z) Sales Order Cost Revaluation
Maintenance Prog i —%*#" % Sales Order Credit Maintenance

) Sales Order Credit Inquiry

[@ Sales Order Credit Report (=

m

n— T Favorites
Menu Collection —{§8) —»| ® (@ SetUp General Ledger
# {=| Containerize Sales Order Shipments

# & Process Sales Orders
Frocess Map _ﬁr-E%ﬁ_. £ Vertical Industry View
=-{i5| My Collection
% Ssles Order Maintenance

[ Sales Order Browse

On the menu, a distinct icon indicates the type of program:
- Maintenance programs
» Transactions and utilities

Reports and inquiries

» Browses and browse collections

Menu collections

 Process maps

Each type of program maintains a specific kind of data within the database.

The next dlides illustrate the types of programs that you will encounter as you use the product
during this course.
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Maintenance Programs

Maintenance Programs

Non-Component Based

ftem Master Maintenance | I

W GoTo ~ Actions | .| Copy ~| @,ﬁ Print »| Preview | §’ Aftach

Preduct Line: (1) (9 UIG-6163: (1) @ Item Mumber: (2)

I I Prwe—— Component- Base

P Mem P [=mDzz P ) = N . - -

i g | go e Actions ¥ 2 Tools 7| & Attach | @‘ Print +| Preview

Attachments
[tem Mumber:
Unit of Measure: GL Account [l
D escription @ I
ltem Data GL Type ‘Standard Account - |
Prod Line: Active v Eudget Group - ,,7/"9
Status: Budget Enabled J  Category |‘_AS§".
Design Group:
Added: Posting | Currency " Analysis "Hepurt LinK" " a "Defaults
Ve lovanton: Date
| Balance Sheet Account V_| Diehit/Credit f_Deb\t '_‘

AutoManual f_Manua\ v'
Intercampany Accaunt __
Fired Intercompany

Maintenance programs create and maintain basic codes such as customers, inventory items, GL
accounts, currencies, and other data. They are also used to record data that initializes business
activity in amodule such as sales orders and purchase orders. Most maintenance programs update
static data, which is changed infrequently.

Entering data in a maintenance program creates a record in one or more tables controlled by the
maintenance program. For example, item records are stored in the Item Master table controlled by
Item Master Maintenance.

With non-component maintenance programs, al changes to the record are made in the same
mai ntenance program. In component-based maintenance programs, changes are made in separate
Create, Modify, or Delete functions.
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ltern Master Inquiry - 5i24/2010.. % |

Inquiry and Report Programs

Site Description
Ttem Number: 010

n Item Master Inquiry
QAD Itern Cost Report |Item Cost Report - /2472010 1. %

05f24/;

Line Description

Site: 10-10-100

UTtrasound Mfg Site

10 Finished Goods

7 01010 EA Medical Ultrasound
Prod Line: 1C
. Added: 01 Cost Set Material Labor Burden Overhead
Design Group: PR
Promo Group: ME
Current 225.71 19.34 0.28333 0.00
13,/01/10
ABC Clas Standard 225.71 19.34 0.28333 0.00
Lot/Serial Controys o110
59t
Locatic 01011 EA Supplies Kit
Location Ty
Auto Lot Number Cost Set Material Labor Burden Owverhead
Lot Grou
Article Numbe
Current .00 0.00 .00 0.00
13,/01/10
Corp Comm ot Standard .00 0.00 .00 0.00
Ship Weigh3m1/10
Freight Clas
01020 EA Implantable Ultrasound
Cost Set Material Labor Burden Owverhead
Current 144.815186 25.09176 0.36372 2.00
13,401,410
Standard 144.815186 25.09176 0.36372 2.00
13,401,410

Inquiries and reports retrieve and display database records.

« Inquiries are primarily used to answer specific questions and are typically viewed online,

although they can be printed

 Reportsusually provide more detail and are printed for arange of datarecords. You select data
by entering a specific range of criteria, such asitem number or date. Reports are often sent to a

printer or file. Other output options such as e-mail are available.
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Component-Based Reports

GL Account List % |

< Tools | &b Print » Preview  Variant =

Repon Vaniants
Fiter

GL Account €%
05000 y,

FACTORYDEFAULT bt

Component-Based Reports

GL Account List

- QAD

GL COA Element TySys Type DebitiCredt  Balance/PEL  Auto/Manual  Analysis Type
Account
05000 STAMNDARD DEBIT BALANCE MANLUAL Maone
05600 STAMDARD DEBIT BALANCE MANUIAL Maone
03610 SYSTEM RESULTCURRENTYEAR CREDIT BALANCE AUTOMATIC Maone
05620 SYSTEM RESULTPREVICUSYEAR CREDIT BALANCE AUTOMATIC Mane
09000 STAMDARD CREDIT BALANCE MARLAL Maone
09100 STAMDARD CREDIT BALANCE MARLAL Mone
10000 DEBTORCOMTROL DEEIT BALANCE AUTOMATIC Maone
10100 DEBTORDOCUMER DEBIT BALANCE AUTOMATIC Maone
10200 OPENMITEM DEBIT BALANCE MANLAL Maone

Server Output Processing 10300 DEBTORCONTROL DEBIT BALANCE AUTOMATIC Maone
10600 DEBTORDOCUMER DEBIT BALANCE AUTOMATIC Maone
11300 STAMDARD DEBIT BALANCE MAAMUAL Maone
12200 BAMNK DEBIT BALANCE MARNUAL Maone
12201 BANK DEBIT BALANCE MARLIAL Maone
13000 STANDARD DEBIT BALANCE MAANLIAL Maone

Component-based reports have multiple output options, including viewer, printer, and export to
PDF, XLS, and DOC standards. The report output is easy to customize, and you can create an

extensive set of reports with unlimited report variants for many output types.

You can run areport immediately, or choose to schedule it to run later. In this case, a pop-up
window opensto let you enter details for running the report at alater date.
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Programs

Ship-To:

Transaction Programs

Purchase Crder Returns Non'Componeni Based I
W GoTo ™ Actions v | .|| Copy ™ kE‘,*.J Print % Preview ﬁ Attach
Ordercall07 () Purchase Order:cal107 &) Ship-From:MD100
Purchase Order: calll? Supplier: dt100 Status Effective: '_5-24\-"2010 -
RTV Ner:| 1234 Itzly Dist Site
Journal Entry Create X Componeni- qued
Ship-From:| MD10C # GoTo ~

fctions T 4 Tools 'I & Attach I T.E,',l Print s Preview

| 61100 Attachments
‘Year [ emo| 05| Pasting Date
Daybiook Code |JE | 000000001 | & | | save s Template
D escription | Joumal Entry ‘ Template Code | /7: Replacement
Original Posting [ Pl Secuerice Nk |—_DD_UD_DD_UD_D1
Reference e -
GL Account 4 Sub-AccountC ¢ CostCe ¢ Description 4 Trans Curr 4 TC Debit L} TC Credit

1100 Expensze usD 0.an

1,000.00
0.00 -

Transactions express the core business activities of a company. They control and record activities

related to busin

ess documents such as sales orders and invoices. Example of transaction are

shipping a sales order or receipt of a shipment for a purchase order. Enterprise Financials
transaction programs include Customer and Supplier Invoice Create and Journal Entry.

Most datain the database is transaction data. Every day, sales orders come in, purchase orders go
out, and work orders make demands on and create material for inventory. These events result in
transactions, which are stored in transaction tables. In contrast to control programs, transaction

tables are const

antly updated by users of the system.
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Control Programs

Control Programs

‘Work Order Accounting Control X I

% GoTo ~ Actions ~ | Ll| Copy = | 'Eg Print &) Preview

Post variances at SFC J

Qty Complete Mihd; SUM 1 cussaoos

Work Order Contral X
4 GoTo ™ Actions 7| .| Copy ~ '%_-l Print a Preview
Auto WO Numbers: ¥
Mext Ww/i0 Nbr: 1022

\work Order Comments:
Routing Comments:

Move First Operation: ¥

When you implement amodule, you enter data that the system uses later to control the interactions
with users and with the database. This datais stored in control tables.

Control tables enable you to adapt QAD Enterprise Applications to your environment. The data
and settings in these tables determine how certain programs are displayed, the numbers assigned to
transactions, the GL accounts for particular transactions, and so on. When you can manage a
typical manufacturing function in more than one way, control settings enable you to establish a
preference.

This dlide shows two control programs with settings that affect work order processing. To support
the enhanced segregation of duties features of QAD Enterprise Edition, financial control settings
are updated separately from operational controls. For example, Work Order Control (16.24) under
the Work Order menu in Manufacturing has only the operational control settings for work orders.
All of the financial control settings for work orders are in Work Order Accounting Control
(36.9.11) under the Operational Acct Controls menu in System Administration.

Note Thisisunlike QAD Standard Edition, where al control settings for afunctiona areaare
updated in one program.
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Program Options

Program Options
Menu Optiong e x |

& GoTo ™ Actions = 7 Tools = & Attach '.I,‘;'..a Print ' Preview |
GoTo _ :
= Purchase Order Returns X| J
ACTIOHS % GoTo * Actions *| .|| Copy ™ '; Print a| Preview ﬁ Attach
» Workflow (nhon-component programs)

Export Data (non-component programs)
+ Save and Browse Drafts (component programs)

Tools (component-programs only)
Workflow
Design

Toolbar Options
Copy (nhon-component programs)
Print and Print Preview
Attach

The menu options for browses are described in Chapter 5, “Browses in the QAD .NET Ul,” on
page 81. This section describes key menu options on maintenance and transaction programs.
These options differ somewhat between component-based and hon-component based programs.
Component-based programs have an Actions menu and a Tools menu; non-component based
programs have only the Actions menu.

This table summarizes differences in the program menus.

Non-Component Based Component Based
Go To links are added manually using User Tool Go To links are supplied automatically by the system based
Maintenance (36.4.8.5in EE, 36.20.4 in SE). on the structure of the program. Theseinclude related views

and other options based on the field currently in focus. For
example, when GL Account isin focus, you can go directly
to creating a new budget group.

No Tools menu; Workflow optionison Actions menu. | Tools menu includes Workflow and Design Mode. Users

Design customizations is accessed directly through with access can modify the user interface appearance of the
menu-level programs and right-click menu option. program.
Simple workflow with link to program. More complex, structured, and predefined workflows.

Actions menu is mainly simple record-level actions. It | Actions menu is more complex and changes based on
includes an Export action that creates an XML file. specific program context. You can save and open draft
versions of a document.
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Go To Menu

Go To Menu

Sales Order Maintenance * |

M GoTo ™ Actions = | L] Copy 7| E‘.:!';J Print 4] Pre
PO Maint ) ~ Order
Add Link
[ Header I [- | 2 fo B >
Header
Order: _-_. -
GL Account Create
& GoTo - Actions ¥ % Tools " & ittach ' L.E'..J Print  s] Preview
Related Views ]

L3

Create Mew Budget Group

@

Create New GL Account Unit of Measure

wL rpps |

Active v Budget Group
Budget Enabled

Non-Component Based Programs

The Go To menu for non-component based programs such as Sales Order Maintenance displays
the Add Link option. Use Add Link to create links to other programs using User Tool Maintenance
(36.4.8.5inEE, 36.20.4 in SE).

Component-Based Programs

The Go To option for component-based programs displays Go To options and Related Views.
Related Views are commonly used views and reports that apply to the record you are currently
working with.
Go To behaves differently depending on whether the current field has dataiin it:

- If the field has avalue, Go To invokes the View activity.

- If thefield is blank, Go To invokes the Create activity.
All of therelated views take the record you are currently using asthe base for the information. You

can simply click the Go To to see the Create New Budget Group or Create New GL Account Unit
of Measure.
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Program Actions Menu

Program Actions Menu

J|Sa\es{)nﬁerMaintenam:e "| I

¥ GoTo v Actionsﬁ_: Copy ~ ‘:E{, Print &) Preview | # Attach ~

Header Ling®p Next
P Header | ¥ Back

jhtDats P Szlesperson P Delivery P Consignment P Comments

Header Next Record .
Customer Create X
Order: | Previous Record
Insert I
Sald-To B Wordlow Undo Cirl+Z
E-mail Customef | Save Cirl+5 7] Letive v
Ul CopylinkToCipboard  Business) ) SweandCreate Gk [7][3)] Bill-To Customer
Export Bote Save As Draft : -
Busined 5 craate Ctrl+N anking H Defaulis ” Credit lelt” Tax Info || Comments
' View Ctri+B
Nam
& Modify Cirl+0
Add
Details * Delete Cirl+D
Credit Limit Maintain
Properties...
Zip)
Exit Alt+F4
Cou
State
County
Telechans

The Actions menu lists active commands that apply to your current program context.

Non-Component Programs

For non-component based programs, Actions options include navigation commands such as Next,
Back, Next Record, and Previous Record. These commands let you navigate to the next or
previous frame, or display the next or previous record for the current field. You can also use the up
and down arrows on your keyboard to display next and previous recordsin key fields or when the
field has been defined to support next/previous processing.

For non-component programs, you can also choose workflow to send alink to the current program
to asystem user (see page 72), e-mail to send alink to an external user, or Export Data, to create an
XML test file (see page 73).

Component Programs

The Actions menu functions in a similar way for component-based screens, with some additional
features. General activitiesinclude Undo, Save, Save and Create, Save as Draft (see page 74), and
Properties. Record-specific activities in the example of the Customer Create program include
Create, View, Modify, Delete, and Maintain Credit Limit.
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Workflow
Customer Create % Componenf
W GoTo - Actions = 42 Tools | &l Customer Create [
! ® GoTo ~| (= Print & Preview | # Attach -
Customer Code _(3204_9 S
T ; Workflow N \ [= [ Loaa sto
Business Relation | Ll I wieme =] |# l—'el
Role -
Business Relation 1N
Il  Reguired Activity -
|
Name [WalMart || Fesum o Sender
Address |_?D25 W8t
i:‘.'\}atrellfﬁzrr;tr | Instructions
Sales Order Maintenance X| ND“-COmponent I
BC w GoTo - Actions ~| Ll| Copy ~| I',,r;'y Print ] Preview | & Attach - I
Header Lines Trailer |Sa|esOrder Maintenance |New Message X|
P> Header P Details B TE]?.‘I'-fO + Send | save
Order. | [NEHEHN Pel
g o |
Solé-To Ce: |
Wal-Mart Bec: |
702 S, Bth Street Subject | Scles Order Main {10510010)
‘Waterfront T YU =
Heniomalle Sales Order Maintenance (10810010)
USA - TAX PURPOSE

Workflow isavailable for both types of programs and is visible as an Actions menu option for non-
component based programs and as a Tools menu option for component-based programs.

Non-Component Based Programs

When you click Workflow in a non-component based program, the system creates a message for
another system user, with the current screen as an attached link. This message is then posted to the
user’s Inbox using the .NET Ul’s internal messaging system.

You can also send an e-mail link to non-system users with your PC’s default e-mail system.

Component-Based Programs

Workflow lets you forward final or draft work items to one or more individuals—identified by a
role—in the organization for completion or validation. You activate workflow using System and
User Settings.

You use the Workflow object dialog to specify the name of the workflow, the role of the recipient,
and activity they are required to perform on the link.
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Record Program Actions

Record Program Actions
Sales Order Maintenance *

M GoTo W Actions V| La]ive

Sales Order1000 @) Nest
Header Lines ) Back

P Header [ Nesxt Record

Head
macel Previous Record

Inzert

2 workflow
Sold-To :
E-tnail

A2 R )
E Save | B Start @ Pause | " Options ~
Program Name Comment

*

Fl popomt.p Purchase Order Maintenance
Action Frame Target Field Comment
»+ I |
'S next a ,_nbr

submit 8 po_nbr
submit 3 po_vend
submit 3 po_ship
submit b po_ord_date

4 &

The Export Datafunction isatest utility in the QAD .NET Ul and isavailable in the Actions menu
for al non-component based programs. This function lets you record your actions as you complete
an application process and save the recorded actionsto an . XML or .XLSfilethat you store
locally. You then execute the saved . XML or .XLS file in the Execute Document Import function
to reproduce the recorded process on screen. Saved files can be exported for testing to another
QAD .NET Ul environment, or imported into the current environment.

1 Launch aprogram.

2 Choose Actiong|Export Data. An Export Data screen is displayed (minimized) on the screen
while the system is recording your user actions. Each user action isimmediately listed in the
Actions grid of this screen, and you can pause, name, and save the recording in this dialog.

3 Enter avariety of actions for the program. These actions are now recorded. The Export Data
dialog lists the actions, frames, and fields being recorded.
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Saving and Browsing Drafts

Saving and Browsing Drafts

J Change System Settings K|

- W GoTo ~ Actions ~ 4 Tools 'i @ Print & Preview
Actions =% Tools = # Aty
Undo Ctri+Z Active ¢ Setting (]
Use Language Specific Object Description

H Save Ctrl+S

i) Saveand Creats [_] " Business Logic Version Checking
Save As Draft — Ciald Canits

| Systemilzer setting * |

# View Citrl+B | , Actions = 37 Tools *| L‘.;'.,' Print & Preview
= Modify Cri+Q - -
| Active 4 Setting
¥ Delete Ctrl+D N » Diaft [retances
Transient Create ] Businesz Logic Yersion Checking
Transient Modify ] Field Security

Automatic Save of Grd Settings
Reverse X X
Automatic Save of Lazt Used Browse Settings
Allow Save of Grid Settings

Transient Reverse User-Defined Fields

=
v
Reversing Jounal Create v
vl
E Erowse Drafts I Event Publishing
vl User Interface Customization
vl Woarkflow
bl

Enable Persistent Cache

FProperties...

Exit Alt+F4

The Save as Draft and Browse Drafts options are available for component-based programs only
and must be enabled by an administrator in Change System Settings (36.24.5.1). When Save as
Draft is enabled, you can save selected records without completing all the validations required to
ensure that the record is complete. You can then finish adding data to the record at alater time by
using the Browse Drafts option to find the incomplete record.

Only the following subset of components provides the ability to save unfinished records as drafts
to be completed and approved |l ater.

» Banking Entry

 Business Relation

» Petty Cash

» Customer

 Customer Invoice

 Finance Charge

« Journal Entry

 Supplier Invoice

« Supplier
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Copy

Purchase Order ke rbenares

- Jele* Agwyen * Capy ¥ 2 Pree 5 Prevew
Handed  Limas
" Hoodw » [ | 3 ™ » > L > »
Heade:
Puschaie Dulee 1000 Supcle:| IND So-le 0D
S Lel
Fage e
S Fis B Fomsst Viea Help
Frama: wsadar
Purchase Order: 1000
Supp! fer 310
Dwege L ERE ship-To: 12000
Frase:  Suppl la
Untwe Shaben Page Inz,
10 matn Street
P chicago
. 00818
Ondet Dtwe L5008 Pacs Thi united states
et Dire LE00R Dise T Frana:  ship To
i Blam
By Lnbsc o 21 ventura Blvd,
[ 1 Siw Lot Angalés
<a
Cyeuihb Daybocd S AP 3210
A [ 4 state
Certroat terane:  petalls
Order Date: o1/00,/2000
Gt Price To1
conffirming: rue
Rersabx: iy nH-rt-a_ false

The Copy menu is only available for non-component based programs and lets you to copy the text
of the current screen to the clipboard, or copy an image of the current screen to the clipboard.
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Print
Print
| Purchase Order Maintenance x|
® GoTo > Actions *| . Copy ~| & Print 18 Preview | # Atach
Order114 ) Purchase Order114
Header Lines Tialer
P Header D Detal: B Tacinc B Logistics B Debvery B ERAS B Consignment D Comments
Header
Purchase Ordet:| 114 5] Supplier. 30%2 Lt bnann
£ | ‘ uppl 2
Printer
Suppber
N
Acme Supply Co. Fetos
. ] Status:  Ready
1 Clanidge D
Hoe Diive Type: Amyuni Document Converter 251
Wheree  LPTT:
Wesona MY 07044 Comment: ™ Printto file
Undted States
i~ Print range: 1 - Copies
i, &+ Al Mumber of copies: 1'\ a.
etai
€ Pages from [0 wcln
Order Date: 29/07/2009 Price Thk - @ CEE] F Cotate
Selpetine
Due Dater 30/07/2009 Disc Thi eenid .
Buper: Ln Dise:
Cancel
ouTe ot o =] oo |
Saleslob: Daybook Set: defap Credit Terms: 2/40PR0X 0.00
Conract: Project: Ertered By: kie
Contact Fleguested By,

The Print and Print Preview options are common to both types of programs. Print printsthe current

screen to the default printer and Preview generates a preview of what will print for the current
screen.
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Attach

Attach

Sales Order Maintenance %
L

‘# GoTo ¥ Actions W | | Copy ¥ =) Print 4| Preview ga) Ak
s Gt — 1| #| Sales Order:10004 (1) —
Sales Order: 10004 1) (»)  Order: 10004 .
. &' Order:10004
Header Lines
P Header » P > > : > > >
Header
Order | 10004 P Sold-To: CLZ500 Bill To: CU2500 Ship-Ta: CUZ500

Sold-To Ship-To

Attach lets you attach any type of document—such as a Microsoft Word file, graphicsfile, or
PDF—to arecord within the application. This integration ensures that al required documentation
isimmediately accessible when needed. You can attach and view any type of fileif the
corresponding viewing software is available on the client. Thisis applicable to both component
and non-component based programs.

A copy of the attached document is stored in the system database, which means that the document
is always available and consistent with the application data.

Example Usethe Attach option to associate a summary of a customer’s business activitieswith a
customer record or attach a PDF of an invoice to a supplier invoice record.

To create a new attachment, click the Attach icon in the toolbar. A standard Windows Open dialog
displays so you can select the document you want to attach. The number of attached documents
displaysin the menu. To see the attachments, click the chevron in the top bar on the screen. Each
linked document displaysin this view and can be removed if necessary.
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QAD Messaging

@ Applications
|

% Purchasing

# {7 Purchase Requisition Menu
# Global Regquisition Menu

+ i) Blanket Purchase Orders Menu
4 ]

.f Favorites
[ Quick Search

= Messages

X
 Inbax (1)}
Sent
Drafis
Delated
HMlerts
Workflow
Folders

QAD Messaging

File Edit Tools Workspace Window Help

i Messages - Inbox *

B View | 5 New | = Reply 12 Reply All = Forward | | Move 3§ Delete 2 Print | & Refresh

| | Filter on: From ~ | Filter

From Date v  Subject
Demo User 821/20124:3357PM  Purchase Order Maintenance (PO011101)
DemoUser 8/21/2012 43846 PM  Sales Order Maintenance (10510015)

Demo User  82120124:38:20PM  Sales Order Maintenance (10510012)

From: Demo User
To: Demo User

Subject Purchase Order Maintenance (PODT1101)

Purchase Order Maintenance (PO011101)

# Hide Details

QAD Messaging is amessaging and internal e-mail system within QAD applications that |ets you
send messages to other users of the system. When using programs, browses, inquiries, and process
maps, the QAD Messaging sidebar is permanently available on the |eft side of the application area
for sending and receiving messages. You can also use Messaging to process program or browse

workflow messages, which include links to programs or browses.

To send a message:

1 Click the New icon.

2 Inthe Tofield, enter the user IDs or names of the users to whom you want to send the

message.

3 Inthe Subject field, enter text indicating the subject of the message.

4 Inthe content area, enter or paste message content.

5 Click Send to send the message (or click Cancel to cancel it).
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Summary

Chapter Summary

In this section you learned about

The types of programs in QAD Enterprise
Applications

The various program menu features for both
component and non-component programs

How to use QAD Messaging

Exercise and Knowledge Check

1 SalesOrder Control is an example of what type of program?

2 In Sales Order Maintenance, select the Go To function. Add alink to the Sales Order Browse
program sobr009.p.

Open up asales order and Go To the Sales Order Browse.
3 Select GL Account List, run the report, and send the output to a printer.

4  Display an existing sales order in Sales Order Maintenance by selecting it from the lookup on
the Order field. Send the sales order to your user ID by using the workflow.

a Click Actions and select Workflow.
b  Enter your classlogin.

¢ You should see the message appear in the Messages area of the Ul. Open the message and
see what information isincluded.

5 Create adocument in Microsoft Word. Save it to the c:\ drive and attach the document to a
purchase order.
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Chapter Objectives

Chapter Objectives

« Understand the features of browses in the
QAD .NET Ul

« Know how to customize filters, sorting, and
display options in browses

+ Know how to create operational metrics
and charts
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Chapter Benefits

Chapter Benefits
« Be familiar with the different types of
browses in the QAD .NET Ul

+ Know how to use browse features 1o find the
exact data you need

« Understand various ways of displaying
browse output
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Training Flow

Training Flow

« Introduction

+ Navigation

+ Application Help
- Programs

- Browses

« Character Ul

- Dashboards
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Introduction to Browse Topics

Infroduction to Browse Topics

Lookup Browses
Power Browses
Browse Actions Menu, Export to Excel, Report
Browse Setup Menu
Filters and Operators
Column Options and Right-Click Column Options
Grouping and Summarizing
Component-Based Browses
Stored Search and Filter Fields
Right-Click Options and Excel Integration
Browses as Favorites
Quick Search
Using the Chart Designer
Operational Metrics

This chapter covers the following topics:

L]

L]

L]

Lookup Browses
Power Browses
» Browse Action Menu, Export to Excel, and Report
» Browse Setup Menu
« Filters and Operators
» Column Options and Right-Click Column Options
- Grouping and Summarizing
Component-Based Browses
+ Stored Search and Filter Fields
» Right-Click Options and Excel Integration
Browses as Favorites
Quick Search
Using the Chart Designer
Operational Metrics
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Lookup Browses

Lookup Browses

f=

FlCust

r Master
Sold-Ta:
el 7' Actions ¥ é_b Print
Search
iCustomar e | |starls at - | | ,(O[ 0‘] - |
Records per page: |J QD 'J T;\) @ G‘)
Customer A % Sort Name 4 W Telephone % 7 City “ W State
w/a-Mart Bentanvile
10C100 MediLogic Bridgewater M
10C1002 Houston Automotive Grop Houston TH
10C10028 Houston Automotive Grop Houstan =
10C1003 Pacific Health Care Systems Loz Angeles Ch
Line Pricing: 10C1004 Price Chopper Schenectady MY
Marual 10C1005 Rockland Industrial Company Rockland MJ
B bookis T0IMTCUS QM - USA Division East Hanover hL
t
Fooonme 11C1000 Cipacath Technologies Inc. Kikland ac
Efiannel 11C1001 Chiro Foods imited Edmanton AR
Project: 11Cio0z2 General Motors of Canada Oshawa

Lookup browses return the value selected to the active field in a calling program. The lookup
browse has limited functionality. L ookup browses cannot filter, graph, or print data

In the example, when you select the Sold-To lookup in Sales Order Maintenance, you launch a
lookup browse of Customer master.
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Power Browses

Customer Browse for View %
Actions = ¢ Setup ~| @) (1) (& & ¢ Add to Favorites 5_’, Stored Searches ~ | E 20 :2 | | Create g Modify 3§ Delete
Search (3) =)
Comeos s <] AT +
:Busmess Relation v |equals - ;j = | + X
_Name v“_.;aquals 5 - |- + X
Viewl | sales Order Browse X o
s Actions = # Setup »| (@) (1) (») () 50 AddtoFavorites | E & G | Create g Vief
B search [
1 i : TRt
Order ¥ | |starts at - 22 @ - +* X Search Clear All o
2 Viewing 1-100 of 839 Records per page:| 100 - o
3 Order # Sold-To ¢ Status Line Iltem Number & UM Qty Ordered Qty Open Due Date Qty Shipped Quote & Type Purchase Order ¢ Ship-Td
3 10510010 10C1000 1 60007 EA 100 100 10142011 0.0 1oct DDgI
10510015  10c1003 1 01010 EA 200 200 81372012 0.0 10c100]
[ § 1051001 ez . e EA 812172012
. 7 . Sales Order Master . S
1E‘F Shipment Transactions EA 200 200 8/28/2012 0.0 10c100:
; = . ) EA 0.0 00 8/24/2012 0.0 12C100
| Sales Order Credit Maintenance
AUTOZ (g : g i EA 0.0 0.0 0.0 22C100
|2 Pending Invoice Maintenance
CA1284 | @) Sales Order Maintenance 1.0 1.0 5/5/2012 0.0 R 20C100
CS100021 ZTCTO02 -1 04007 EA 0.0 0.0 0.0 21C100

A power browse can filter, sort, print, and graph data. Columns that cannot be sorted are generally
non-indexed fields. Sorting by them degrades system performance. Component-based and non-
component based browses share many of the same navigation features:

1 Usethe navigation buttons to move through the records. The buttons from left to right move to
thefirst set, previous set, next set, last set.

2 Drag columns by their headingsto rearrange the display or click any column heading to sort in
ascending order; click again to sort in descending order.

3 Bluetext indicates adrill-down. Right-click any value to display associated links: either a
more detailed browse, arelated program, or an external Web page. This slide shows the drill-
downs associated with the Order column.

Note Component browse drill-down applies to the whole record not a field.

4 Usethe Records per page drop-down to determine how many records display at onetimein
the browse. The default value can be set using the Rows Per Page setting in Tools|Options. (In
QAD SE, the Max Browse Records field in User Options Maintenance does not apply to
browsesin the QAD .NET Ul.) Some browse options are only available when displaying All.

Important Attempting to display alarge number of records at once can adversely affect
performance. Instead, use search conditions to focus on specific records you want to review.

5 Click Clear All to clear browse results.
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Browse Actions Menu

Browse Actions Menu
Sales Order Browse X I
Actions ﬂ/ Setup | (@) (@ (® & Add to Favorites 8 3
li Chart
‘,'_!',; Print - |l s0 -"'l[z = + ¢ Search
E ExportioCav Rmmdsperpage"‘lfx} hd
] Export to Excel
E b Line Ihem| .
Custof B for Vi <
L Exportto PDF m ustomer Browse for View
= Workflow 2 0 Actions ’ Setup ~| @ @) B & ¢ Add to Favorites B_" Stored Searches = | E =1
_ E-mail 3 0302 (g Chart
.| Copy Link To Clipboard 40303 & Print -] Pl=]-| | + = []
[@ Report 5 0309 Export to CSV = /E:)'@ o | + %
@ AutoGo »| 60400 5 Exportiobxcel — :E] _ :_ &
SO0T1302 10CT000 1 0302 5 Export to PDF 3 : —_— -
2 Records per ;100 x|
50011302 10C1000 2 0302 ol b pex-paoe|
50011302 10C1000 3 0302 ¥ %7 Business Relation Code & W Address
Q Report
50011302 10C1000 4 0303 s Ltd 31-C1002 Fitt Strest
& Auto Go 3
50011302 10C1000 5 0308 Toro oo v 10-C1000 702 S\, Bth Street
50011302 10C1000 6 0400 21C1002 \/an Hess Foods International 21-C1002 Transito 1
50011303 10C1000 10302 22ci001 Teasdale Hospital Equipment 22-C1001 120 Mentor Hse
31C1003 Sanitarium Health Food Co. 31-C1001 Market Street 55
31c1o01 Sanitarium Health Food Co. 31-C1001 Market Street 55
10C1005 Rockland Industrial Company 10-C1005 566 Rockland Boulevard)
22-300 QMI-UK Division 22-UK-CO 50 Main Road

The Actions menu contains export and reporting options, as well as additional workflow and
e-mail options in non-component browses.

Chart. Select Chart or Grid View to toggle between viewing a chart or the grid view of a
browse. If achart has not been created for the browse, the Chart option is not available. Charts
are set up using the Chart Designer on the Setup menu (see page 114 for details).

Print. Select to print the current browse. The system displays the standard Windows print
dialog so that you can select aremote or local printer or print to file. When you print a browse,
al columnsin the browse are printed and scaled to fit the paper size of your printer.

Export to CSV. Exports the contents of the browse to a comma-separated-value (.CSV) file,
which you can open in spreadsheet applications. The export includes only the columnsthat are
marked as visible, so you can exclude columns from the export by hiding them in the grid.

Export to Excel/Export to PDF. Generates an Excel worksheet or a PDF file with the browse
data.

Workflow. Sends the current browse as link to a selected user using QAD’s internal messaging
system. When the user double-clicks the link in the e-mail message, the browse is displayed.

Email. Sends this browse as a program link using the client PC’s default e-mail system.
Report. Generates areport of the current browse results.

Auto Go. Automatically refreshes the data in the browse at a user-specified rate.
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Creating Excel Output From Browses

Creating Excel Output From Browses
Sales Order Browse * I
Actions = ## Setup W W @ ») 5y Add to Favorites |
g Chart
& print o~ O3] - | | + x
Export to CSV ) — = = — - - :
| A B c |.b E F G H I J
[ Dxpatio e Line It| 1 _lorder IISn\d-TD Status  Line ftem Mumber UM Oty Ordered Gty Open Due Date Gty Shipped
T Export to PDF m 2 10510010 [10C1000 1750007 EA 0.0 100 10/14/2011 00
& Workflow 1 01| 3 10510015 |10c1003 1/o1010 EA 200 200 8132012 0.0
| E-mail 5 g1l 4 (10510015 | 10c1003 2010 EA 200 200 8212012 0.0
|| Copy Link To Clipboard 3 07| 5 [10510015 [10c7003 | _ 301010 |EA 200 200 8282012 0.0
P 10z 6 [AUTOT 121001 | _ 1/02200 [ | 09| 00| 42012 00
© AuoGo o| 1z 7 [auTO2  22C1000 1/02200 EA 00 00 00
CAI2ed I0C1002 101 8 .CA'IZM .ZEC1DDZ | 1’D1D1D | 1.0 1.0 5/9/2012 0.0
.
CS100021 2101002 10 9 [CS100021 |21C1002 | | 104001 |EA 00 00| 0.0
cebws 1101002 1 gz| 10 jesbwst | 11C1002 1102301 EA 00 00 00
r
11 csbws2  12C1001 1/02302 EA 00 00 0.0
12 |csbws3  |21C1000 1/02303 EA 00 00 0.0
13 |so011301 |10C1000 1/03021 EA 1000/ 1000  1/25/2013 0.0
14 |S0011301 | 10C1000 2(03022 EA 1000 1000 /2572013 0o
15 50011301 | 10C1000 303023 EA 1000/ 1000 1/25/2013 0.0
16 |SO011301 |10C1000 403033 EA 1000 1000  1/25/2013 0.0
17 |so011301 | 101000 503090 EA 1000/ 1000  1/25/2013 0.0
[‘Data , Search Conditions . Info '.|'"‘5i3 & [ e [

Click the Actions menu and choose Export to Excel.

The export creates three worksheets in an Excel workbook, which is opened for display.
 Data. This page contains the actual data columns and headings from the printed browse.

» Search Conditions. This page displays any search conditions used to filter the printed data. The
conditions listed are field name, operator, value, and, for a range operation, the ending value.

« Info. This page lists details about the report generation including the ID of the user generating
the report, the date the report was generated, the name of the browse, and the browse program.

When you export data to Excel, any grouping is retained in the output.
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Browse Report

Browse Report

Default Daybook Browse ‘

Actions Eﬁ' Setup 'i @ @ (» & 5 Addto Favorites | B =3 : | [
iy Chant 1
& o S - .
Expoditoioy Records per page: !‘H}Diﬂ
%] Export to Excel r -

& From Entity £ ¥ ToFntibr £ 57 Davhonk:

L Exportto PDF Dt Dipbook Browss. * [Repen - Default Dayboai Braw. *
; e
= Workflow

= nint | |l e o Refresh

=] E-mail CO0m @ @ faget ®® 6 wox |6
| Copy Link To Clipboard
B Report
n Default Daybook Browse
Auto Go 3 QAD HUSA 0
IC RCT-PO TrnsType  DocType  FromEaity  ToEnity  Daybook
Ic RCT-SOR i - i
Ic RCT-UNP [ 183-PRY 155-PRY
" e 15380 158:50
Ic RCT-O © 1SS-LNP IS5-UNP
W0 WO-CLOSE i 138-W0 wotss
[ MATLVAR WOUVAR
ic RCT-PO RCT-PO
e ROT-S0R RCT.50R
ic RCT-UNP RCTANP
< RCT-WO WORCT
wo WO-CLOSE WOCLOSE
End of Repont

The slide shows the output of a browse when Report is selected from the Actions menu. The data
displaysin areport viewer and can be printed as needed.
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Browse Setup Menu

Browse Setup Menu

Sales Order Browse X

Actions ~ i’ Setup -| D @ @ =) ¢ Add to Favorites

Search @ Chart Designer
Order |i Reset '| £l Sort Columns

#' Reset to Factory Settings

Viewing 1- 100 of 839

Order »~ SoldTo £ Status Line ltemMNumber £ UM Qty Ordered Qty Ope

| J 10510070 10C1000 1 60007 EA 10 10

10510015  10c1003 1 01010 EA 20 20
10510015 10c1003 2 01010 EA 20 20
10510015 10c1003 3 01010 EA 20 20
AUTON 12C1001 1 02200 ELX O o
AUTO2 22C1000 1 02200 EA O t]

The Setup menu lets you access the Chart Designer discussed later (see page 104) and two reset
options.
» Choose Reset|Sort Columns to change the direction of all column sorts back to initial settings.
» Choose Reset|Reset to Factory Settings to reset all aspects of the browse. Selecting this option
changes the search criteria, the setting for number of recordsto view, and all aspects of the
columns in the browse.

Note A similar Reset to Factory Setting option displays when you right-click the column
headingsin abrowse (see “Right-Click Column Options’ on page 94). Choosing this option resets
only changes made to columns such as size, order, and sort direction.
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Filters and Operators

Filters and Operators

Sales Order Browse X l
Actions = , Setup »| (@ &) (® () 1y Add toFavorites E S &k | Create # Mog
Search {
E— | - | .
Expires | - .
Vil tem Number, = Records per page: | 100 -
Line
QOrder !m Line Iltem Number & UM Qty Ordered Gty Open Due Date Qty Shipped Quote & Type FPurchase Order & Ship-
Purchase Order
Qty Open
Qty Ordered | 1 01010 EA 200 20.0 82012 0.0 10c10d
Gity Shipped P )
| |Quote _| 2 01010 EA 200 20.0 82172012 0.0 10c10
Ship-To
Site Sales Order Browse X
Seld-Te P = T
Status Actions v ¢ Setup ~| (Said) () (30 i Add to Favorites | B =20 2 | [ Create
P e o o
St [sueTo v [stns ot [ [10c Plal-| |+ [sonh ] [(Goman ]
4 equals —_—
Viewing 1- 100 of B33 not equals rds per page:| 100 'ri
contains
Order # Sold-To & |range mber & UM Qty Ordered Gty Open Due Date | Qty Shipped | Quote & Type Purchase Order &
q 10510010 10C1000 giamsat = 0.0 100 onezn R oo 1)
greater than
10510015 101002 |less than EA 200 200 81312012 00 1
is null -
10S10015 107003 e EA 200 200 2172012 0.0 1
10510015  10c1003 3 01010 EA 200 200 8/28/2012 00 1

1

Filtering. If you are using a component browse and stored search criteria exist, you can select
one by name from the drop-down list at the top of the search criteria. (See page 97 for an
example.) This sets up the filter criteriato produce preconfigured results. Otherwise (and
always in a non-component browse), the search fields display with a default configuration.

Note For non-component browses, you can save a browse configuration to your Favorites
and use the preconfigured criteria.

Refine the search using combinations of filters and wild cards (* and . for Financials browses).

Search Operators. The various operators include equals, not equals, contains, range, starts at,
greater then, lessthan, isnull, and is not null. When an equal sign is displayed next to thefield,
you enter an exact matching value.

Search Variable Mode. By default, you specify values for the search, such as Sold-To equals
C10553. You can aso search on logical relationships such as Sold-To equals Ship-To. Click
the green toggle symbol next to the Search field to toggle between search modes.

To refine your search further, click the plus (+) icon to add another search row. You can add as
many rows as needed, each with different search values and operators. If you choose the range
search operator, the second search box is enabled for the ending value of the range. Use the x
button to remove search filters you no longer want.

MQAD



Column Options

Browses in the QAD .NET Ul

93

Column Options

Sales Order Browse X

| || Create o Mg

Actions = # Setup -/ @ @ ) 5 - AddtoFavoritss | B a3 i
Search (1) ) !
[Order ~|[stnsat _ +|[s0 Bl@) - | + % [ seach |[ cearan |
\iewing 1- 828 of 828 Records per page: Al R

Order AW Sold-To & W Status & ¥ Line & 7 | ltem Number &

50011301 10C1000 1 (Al \E.q 100.0
(Custom) Il
50011301 10C1000 2|(Blanks) ;| EA 100.0
C {NonBlanks) -
50011301 10C1000 s 100.0
S0011301  10C1000 4(01011 100.0
2
| soot13o1 1octooo & 04001 EA 100.0
50011302 10CT000 1 03021 EA 100.0
50011302 10C1000 2 03 Actions 7 (=0 Print ¢ Add to Favarites
50011302 10C1000 302 Search : )
ESaIes Order ':‘i !slarls at - : |

Vi*g 197 of 17

o:} * Unit DFME%SU A Uit of Measu A 7

E0-10000:0071 E&

1 B0-10000-007

1 80-10000-001 E&

100.0
100.0
100.0
100.0

100.0

100.0
100.0
100.0

Y| UM & 7 Qty Ordered & W Qty Open & ¥ Due Date & ¥ Qty Shipped & 7 Q

12572013
112672013
12572013
112572013

1/26/2013
12572013
112572013
172572013

oo
oo
oo
oo

oo
oo
oo
00

1 Change the column order by clicking the column header in the browse screen and dragging it
to another position in the resultslist. The double red arrows appear when you can drop the

4

heading in a new position.

Adjust the column size by clicking on the border of the column header and dragging that

border to the left or the right.

Click the column header to sort all datain the result list on any of the columns. Click the

header again to sort the data in reverse order.

When you are viewing al records (Records per page is All), each column header also features

adrop-down filter option. Click the icon to display the available filters. In this example, you
can filter Item Number by all (the default), blanks, non-blanks, or a specific item number. You
can also select Custom, which displays adialog for defining a custom query.
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Right-Click Column Options

Right-Click Column Options

Sales Order Browse X
Actions ~ ## Setup ~| (@) @) & & ¢ Add to Favorites | E 2] &

Search (1)

Order v | |starts at ~||S0 ,':Jlg | | + = Search ‘ Clea
Viewing 1- 828 of 828 Records per page:;_ikll -
Order &V SoldTo ¢ ¥ Status &7 Line & ¥ ltemfumb « ¥ UM &% QivOrdered &5 QtyOpen$ ¥ DueDate & 7
SO011304  10C100T 1 0j04{¥] | Autosize Columns 40 1252012
SOD11307 10C1003 Jogy: || Cathiew 40 12512013
SOO11310 11C1000 10100 | Group By ltem Number 20 112512013
SOD11310 11C1000 50101 Show Group By Box 20 112512013
SOD11313 12C1000 1 0100 e moye Crouping 20 112502013
SO011313 12C1000 50001 Expand All Groups 20 1/25(2013
SDO11317  20C1002 100 Collspse All Groups 30 112512013
SOD11317  20C1002 BIEE |[Shmmary 5 20 112512013
SO081204  30C1001 10101 Clear Al Filters 20 8125/2012
50081207 10C1003 10 DHI = 20 3252012
| Hide Column

50081210 31C1000 1 01014 10 Br2er2012
| Reset to Factory Settings

50081210  31C1000 5 01014 10 82512012
| Columns

50081213 22C1001 1 0101 10 8252012
| Properties

50081213  22C1001 5 0101t 10 3252012

50081217 21C1001 1 01010 EA 2.0 20 82572012

Right-click a column heading to display alist of options.

Use Autosize Columns to resize browse columns based on the size of the displayed data. By
default, the browse displays with columns already autosized. If you turn this option off and
manually adjust column sizes, your settings for each browse are retained between sessions. If a
cell’s data exceeds the column width, three dots (...) are displayed on the right.

Use the Group By functions to create and manage custom views of the browse data. Group By
functions are available only when all records are being viewed.

Use Summary to get a summary of the datain the browse column.
Use Hide Column to remove a column from display.

Use Reset to Factory Settings to return to the default column display settings. The search
conditions, autosizing, page sizing, and chart definition are all reset.

Note ThisReset isasubset of the reset on the browse Setup menu, which resets all aspects of
the browse.

Use Columnsto display alist of al columns defined for the browse and toggle the show/hide
Settings. You can use thisto restore a column that was previously hidden. This option displays
the Column Maintenance screen, in which you select the columns to be displayed and the
position in which they appear on the screen.

Use Propertiesto display technical information about the datain the column. Thisincludesthe
name of the current program and the database table and field where the data for the column is
stored.
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J Sales Order Browse X |

Grouping Browse Resulis

Viewing 1-826 of 826

Actions = # Setup ~ @) Cancel | (@ @) B &
Search
|Order - |starts at -

Records per page: ,:‘-‘».II

¢ Add to Favorites

-

v

Order A T Sold
TRANSZ 20C10
TRAMS1 3oCig
SOEAMT00  10C1C
SOEAMT00  10C1C
SObws10 30C10
SObws10 30C10
SObws10 3ocig
SObws10 30C1g
SObws10 30C1g
SObws10 30C10
SObws10 30C10
SObws10 30C10
SObws10 30C10
SObws10 30C1002

Autosize Columns

Card View

Group By Sold-To

Show Group By Box

Remove Grouping

Expand All Groups

Collapse All Groups

Summary 3

Clear All Filters

Hide Column
Reset to Factory Settings
Columns

Properties

aber &7 UM & w7

Sales Order Browse X

robe Actions = @ Setup | (@ @) (0 & ¢ Add to Favorites

busing Search

|Order v | [starts 2t -

Viewing 1- 839 of 839 Records per pageAH
+ Sold-To:10C1000 (108 items)

+ Sold-Ta:10C1001 (44 items)

+ Sold-Ta:10C1002 (54 items)

+ Sold-Ta:10c1003 (16 items)

+ Sold-Ta:10C1004 (36 items)

- Sold-Ta:10C1005 (3 items)

62 02306

50100001 1 01040-001 EA
50100001 2 01040-002 EA
50100001 939

+ Sold-To:11C1000 (48 items)
+ Sold-To:11C1001 (36 items)

Ha)- [

Order 4+ 7 Status $ 7 Line & 7 ltem Number £ ¥ UM & 7 Qty Ordered & 7

1.0
1.0
00

This slide shows the result of grouping sales orders by Sold-To Each group can be expanded using
the plus sign next to it. You can also add other columns to the grid to create a group hierarchy.

Group options are saved automatically in your last used settings, and can be reused when you open
this browse again. You can also save these options as a stored search.

Add other columns to the grid to create a group hierarchy. Group options are saved automatically
in your last used settings, and can be reused when you open this browse again. For component-
based browse, you can also save these options as a stored search.
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Summarizing Browse Results

Sales Order Browse X |
Actions = ¢ Setup ~| (&) @) (» (= ¢ Add to Favorites B 2 : | Create ## Med
Search
Order o | P e E - + X Clear All
Viewing 1- 839 of 839 Records per page: All -
Order 4V Saus £ 7 Line £V ltemNumber £ % UM £ W Qty Ordered ¢ ¥ Qty Open £ ¥ Due Date & ¥ Qty Shipped & 7 Quot
50700001 1 01040-001 EA 10 10 82472012 0.0
50100001 2 01040-002 EA 10 10 82472012 0.0

50100001 999 0.0 0.0 215201 0.0
Summaries
Count =3
Sum=20
Average = 06666666667
Minimum = 0.0

Maximum = 1.0

The Summary right-click option lets you display summary information, depending on the column
header you clicked. The option is context sensitive and displays choices based on the data you are
viewing. For some columns, you can only summarize by count. But the Quantity Ordered column
can be summarized by the total sum of ordered amounts, count, average, and the minimum and
maximum amounts.

Count. Displays the number of records

Sum. Displays atotal sum of the open quantity
Average. Displays the average of open quantity
Minimum. Displays the lowest open quantity
Maximum. Displays the maximum open quantity

You must be viewing all the records on the screen to use the Summary option. If there are more
records than can be displayed, set Records per Page to All.

Note You only see meaningful resultsif the operator you choose applies to the data type. For
example, applying the average operator to a date column does not produce a meaningful result.

Minimum and maximum are useful with dates, and summary and average with numeric fields.
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Component-Based Browses

Component-Based Browses
Supplier Invoice Browse for Mo.. % |
Actions = # Setup ~| (@) (4) () () 5 Add to Favorites }“‘ Stored Searches ‘h B =0 : | Create # Modify $§ Delete
Search (5) ] Factory Default (4'
SUP‘P“.H Code v | |equals - > E Manage Filter Fields ... X search Clear All
Business Relation ~ | |equals - ,\-JE Save x
Reference ~ | \equals - E SaveAs... x
Year - | |equals - [1 Ceiete X
. Pl . x
Viewing 1- 100 of 661 Records per page: | 100 -
Supplier % BusinessRel ¢  InvDate £ Reference & TCBalance & Cur ¢ DueDate & Description &
[ 105C1005  10-C1005 10/9/2010 OIS HO2 491.50 USD 11/82011 OIS HO2 10SC1005
1051001 10-51001 5/5/2010 PO051001 0.00 USD 6/472010 POOD51001 1051001
1051002 10-51002 5/5/2010 PO051002 000 USD 6/472010 PO051002 1051002
1051003 10-51003 5/5/2010 PO051003 0.00 USD 71472010 PO051003 1051003
1051004 10-51004 552010 PO051004 0.00 USD 7472010 PO051004 1051004
1051005 10-51005 5152010 PO051005 0.00 USD 51572010 POD51005 1051005
1051006 10-51006 5/7/2010 PO051006 0,00 USD 6/6/2010 PO051006 1051006
1151000 11-CS1001 5(7/2010 PO051007 0.00 CAD 873172010 POD51007 1151000
1151001 11-51001 5772010 POO51008 0.00 CAD 5772010 PO051008 1151001

Component-based browses are launched when you view, modify, or delete arecord created with a
component-based activity. For example, Supplier Invoice View (28.1.1.3), Supplier Invoice
Modify (28.1.1.2), and Supplier Invoice Delete (28.1.1.9) all launch browses, in which you select
the record on which you want to perform the activity.

Component-based browses support some unique features.

- Theway linkswork is different in these browses. Right-clicking a record lists programs that
can be used to modify or display information about the record. This linking is maintained
automatically by the system; you do not need to set up drill-down links in the way they are
defined for non-component browses.

 Another special feature is stored searches. The Stored Search menu is shown in this slide.
Using this menu, you can save a set of search criteria under aname. The stored search isthen
listed for selection when you launch this browse and can be reused. The settings you save
apply to this browse only and are not listed in browses for other types of records.

Note With non-component browses you can save a configured browse to your Favorites,
which saves all your settings, but you cannot save the search criteriaand load it directly into
the browse.

- Additional options are available when you right-click abrowse row. Some component browses
support an advanced Excel integration.
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Managing Filter Fields

Actions ~ # Setup v| @@ ®

Supplier Invoice Browse for Vi.. 3{|

¢ Add to Favorites

& Stored Searches ~

|8 2 i

| [] Create o Modify 3¢ Delete

i .Searc.l.'l l'ilﬁ) Factory Default {E
|5UPP|IEF Code - iequals &g | | pi ol Manage Filter Fields ... x
|Businas Relation : |equals - | | ,':j{: Save ®
|Referenoe - | !equals - | | [ deni = B
g ; & Supplier Invoice Browse for View - Manage Filter Fields EI_Ig
| Year - | equals ~ ||
|Daybonk Code & I :equals = | | Label 4 Misible 4 Operator 4 First Initial Value ¢ Second Initial Vaiue!i'
T ] M equals E
|\‘"mhh°|d‘”9 Tax ¥ | |equals = | | Business Relation [l equals i
| . 1T Reference [l equals
Viewing 1- 100 of 661 Records per pag Year vl equals
il [l
Supplier L Business Rel & Inv Date & Reference Dayhook Cade bt equals
- ‘withholding Tax vl equals
| J 105C1005 10-C1005 10/9/2010 Ol SHO2 SC\WHT Base Am els
1051001 10-51001 552010 PO051001 s S
1051002 10-51002 B/B/2010 POOS1002 TC \WHT Base Am equals
1051003 10-51003 562010 POO051003 SCWHT Base Am equals
1051004 10-51004 552010 POD51004 BE WHT Base Am equals
1051005 10-51005 5152010 POOS1005 USRIy [ __CHis
SC WHT Total Am vl equals
10S100E 1051008 sgooin pogstone fil |00 S LL DT M
. BC WHT Total Am Il equals -
o . A
| il |
I oK |[ cose |

Manage Filter Fields displays all the search fields possible for this type of record. You can use the
optionsto:

- Specify whether afilter field should appear on the Selection Criteriatab (Visible column).
« Specify in which order the filter fields should appear.
Specify what operator to use when finding datato view.

Define a persistent initial value or range of values for thefilter field. The values for search
criteria entered in the actual Search Panel are not saved with the stored search. However, the
initial values entered in Manage Filter Fields are saved.

 You can refine the default search for GL accountsto retrieve only accounts with codes that are
within a number range of 1000 to 5000.

L]
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Supplier Browse for Modify * 1

Right-Click Component Browse Options

Actions = ## Setup ~| (&) (%)
Search
Supplier Code - .B’.]LEJS

Viewing 1-59 of 59

Supplier
10-300 10-USA-CO
10L7000 10-L1000
10L1001 10-L1001
10PLATSP 99F5-10
1051001 10-51001
1051002 10-51002
1051003 10-51003
1051004 10-51004

[} 1051005 10-51005
1051006 10-51006

% W Business Relation Code & ¥ Bu gy Activily Dashboard

») () i AddtoFavorites &% Stored Searches ~
) Modify
£ Create
) View
Recordg &) Delete
&) Excel Integration

-

N
&9 Supplier Invoices

K ) Supplier Invoice Payments Place 07302 Jersey City NJ
UT/&) Supplier Balance Street  S0501 Torrance CA
Plz%® Withholding Tax 55466 Louisville KY
Tal§) Supplier Account Activity ue 0 Palmetto FL
Bri{®¥ Supplier Report lad 49127 Stevensville M
He/'@ Supplier Open ltem Report L 11472 Closers WY
Sul ¥ Dump XML eet S0021 Los Angeles  Los Angeles CA
8 &9 Force Publish Drive 07029 Thvingaton i
Hampton Electronics 17031 Commercial B. 33421 Boca Raton kL

Pvenue 07350

8 a :: | Create o Modify
e
+ 3 | Search Clear All

% W ZipCode &+ ¥ City

East Hanover

% ¥ County & 7 State 3
NJ

Component-based browses support additional drill-down and configuration options for individual
records through the right-click menu. For example, when you right-click agrid line in the Supplier
View browse, the options shown in this slide display. Most of the options let you navigate from a
specific record to arelated program. You can select a supplier and then see open items for the
supplier, the supplier’s balance, the supplier’sinvoices, and so forth. The exact options vary
depending on what kind of record you are viewing.

Additional component-based options that are not related to specific records are:

Excel Integration. This option lets you export datainto Excel spreadsheets, create new data
within Excel, and import it to the system database, where it is validated before being saved.

Note Thisadvanced bi-directional Excel integration is supported in only a subset of

components.

Dump XML. Select to export selected linesto an XML file for analysis. You are prompted to
specify aname for the output file and aformat. This option is described in more detail in User
Guide: QAD System Administration.

Force Publish. Thisoption is used with event publishing that lets changes to master data be
published and synchronized with other external systems and is described in more detail in
User Guide: QAD System Administration.
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Excel Integration

Excel Integration

Right-clickthe browse  em i
and choose Excel et |
Integration e

) Inthe empty grid, right- |
click and choose Load O
Suppliers @ m
Right-click and choose
Export to Excel for R e s
Maintenance o 1. b4 Tt Teta_3 St
Save the Excel file, open : e v
it, and modify it = P
Right-click in the grid - I —
and choose Import from = - g :
Excel P o] |

Using Excel Integration has multiple steps. This example uses supplier records.

1 Right click ina Supplier browse and choose Excel Integration. An empty grid displays.

2 Right-click in the empty grid and choose L oad Suppliers. The Load option letsyou retrieve al
database records for a supported business component.

3 When the load completes, right-click in the grid and select Export to Excel for Maintenance.

4  Savethe Excel filein afolder that can be accessed so that the Excel sheet can be modified.
Make the required changes to the Excel file and saveit.

5 Return to the supplier browse, right-click grid and select Import from Excel. Click Save to
create or update the data in the system database.

The changes you made should now be reflected in the database records.

Note With Excel Integration, you can also import from Excel to create new records without
exporting first.
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Browses as Favorites

Sales Order Erowse *
Actions = ## Setup 'i @ @ () (D|5% Addto Favorites | 8 3 = ‘ | 7] Create
E“s‘earciw"iZ] 1
T a- +
[ship-To ~|[stetsat  ~][cutso Pl=2] - | | + =
Viewing 1-100 of 838 Records per page:[ 100 |
Order # Sold-To & Ststus Line ltem Number & UM Gty Ordered Gty Open Due Date  Qty Shipped Quote & Type Purchase Order £
| 3§ 10510010 10C1000 1 60007 EA 100 100 10142011 0o
10510015 10c1003 1 01010 E& 200 200 anazom2 0.0
10510015 10c1003 2 01010 E4 200 200 2172012 0.0
10510015 10c1003 3 01010 EA 200 20,0 Br2gr2012 0.0
AUTOA 12C1001 1 0Z200 EA 0.0 0.0 dradra02 0.0
AUTO2 22C1000 1 02200 EA 00 0.0 00

Non-component browses do not support the Saved Search feature, but you can save both types of
browsesto your favorites:

1 Click the Add to Favorites button.

2 Thebrowseis saved to your Favorites area and named based on the name of the browse.

If it isthe first instance you have saved, the browse name in the Favorites area is the name of
the browse. If you save the same browse again, a (2) is appended to the name in the Favorites
area.

3 Once you have saved the browse to the Favorites pane, you can rename the browse and
organize it in the same way as other items saved in the Favorites pane.
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Renaming Browse Favorites

@ Applications

#HT Customer Management
BT Supply Chain

Eu’j Manufacturing

E‘hj Financials

#HT) Master Data

FHE) System Administration

9.7 Favaorites

#H[E| Set Up General Ledger
" Sales Order Browse
E/Z;alm Order Browse (2)

[

Renaming Browse Favorites

P Acll'ons'f Setup'| .'_;_\J @ @ 9

3‘ Sales Order Browse %

¥ Favorites
|| Set Up General Ledger
-[# Sales Order Browse

m

ﬁ“- Sales Order Browse (2}

/

[2 Rename
E Changelcon
@ Remove
Auto Start
Collapse Menus
Open
Design

Properties

{:D:} Applications

'E‘ =3 Customer Ma

&3 {51 Supply Chain

[+ Manufacturing

= Financials

'E‘@ Master Data

&3 {5 System Administration

7F Favorites
#H{[E] Set Up General Ledger
: ' Sales Order Browse

R L1500 Brovse

To rename a browse;

1 Right-click the browse.

2 Click on Rename.

3 Enter anew name for the browse.
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Quick Search

Sales Order Browse X
Actions ~ ¢ Setup ~| (@ (4) (5 &) 1y AddtoFavorites [ Quick Search
Search (1) [Sersvith - |c Y|
|- Search For L:LE [Stars vith  +| [ =] - e 1l User Dats
Expires T : . -[5F End User Browse
Villiem Number Tii Recoeds pacpaie | 100 hdl . [& CallCollection
Line : | P o
COrder —Status & ¥ Line & ¥ ltem Number 3 7 UM & = (‘} .!.Lstomer ata
’F’urchase Order 1 01010 * B Customer Collection
Qty Open
Qty Ordered 1 04001 EA
Qty Shipped A
Quote 3 1 02301 EA
Ship-To 3 1 02302 EA
Site
Sold-To 1 02303 EA
i 1 03021 EA
2 03022 En
e 3 03023 EA
50011322 30C1000 4 03033 EA

The Quick Search filter (* Search For) isavailable in all power browses and lets you search for a
value across al of the fields in the browse. Quick Search looks for integers and text strings only
and does not retrieve dates.

Use the * Search For option from the Search pull-down list in a browse to retrieve al the results
that contain the search value in any of the columns. Choose the Contains, Starts With, or Equals
operator for the system to use when searching across columns in the browse data.

You can aso create groups of browses for quick search purposes by adding them to the Quick
Search panel. By default, the browse groups area of the panel is empty. Create a new browse group
by right-clicking on the panel and selecting New to create a new browse folder. Add individual
browses or browse collections by selecting the folder and dragging and dropping browses from the
Applications panel.

After you have created the browse groups, select one and enter a search term in the Quick Search
field. Press Enter to search the browses contained in the folder for the term. The results display in
browse format in the workspace.
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Using the Chart Designer

Y Browse Chart Designer — . u|
Browse Chart Designer
X-Axis Label: Product Line i Chart Title:
X-Variable: |Prod Line - Itemn Browse
1

Y¥-Axis Label:  Item Mumber Item Browse

Group By X Values: |.1B a2 30 Wothers

Y-Variables:

|Hem Number X | |Cuunt

! -] | A 400%

- 18.00%

48.00% v,

| i ad |

Item Number

30.00%

Product Line

With the Browse Chart Designer, you can:
» Quickly generate graphical representations of browse data.
» Toggle between the standard browse display (called the grid view) and the chart view.

» Usethe chart view editor to select datain abrowse and display the datain graphical format,
such as apie chart or bar graph.
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Creating Charts from Browses

Creating Charts from Browses

from the Actions menu

Design a chart using the Browse Chart
Designer

Set X- and Y-Axis labels

Set X and Y variables exmmmmms

Browse Chart Designer

Group By X Values ——
Chart Title S
Chart Type e - o
Preview 1

From a browse, choose Chart Designer

The Browse Chart Designer lets you choose settings that define a chart:
X-Axis and Y-Axis Label. Enter the label for the chart’s x and y axis data.

X-Variable. Select the variable for the x-axis data from a pull-down menu listing the available

columns in the browse.

Y-Variables. Select up to five variables for the y-axis data from a pull-down menu listing the

available columns in the browse.

Group By X Values. Select Yesif you want to display all the common x-axis data together in

groups. Select No if you want to display the x-axis data individually.
Chart Title. Enter atitle for the chart.
Chart Type. Select from among the available chart types.

Preview. Click the Preview Chart button to view the chart before you save it.

You can toggle between the chart view and the grid view of the browse by selecting Chart or Grid
View on the Actions menu. If you are in chart view, Grid View is displayed on the menu, and if

you arein grid view, Chart is displayed.
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Chart Options

Chart Options
Rotate and Zoom 3D Charts

Search Charts P
Hide Titles m”’“ L =0
Hide Legend e e —
Launch in New e
Window
Copy to Clipboard s
Edit Chart Design
Interactive Charting “‘:,‘"

Sales Orders

Whilein chart view, you can do the following:

Rotate and Zoom 3D Charts. You can rotate 3D charts by pressing the Alt key and moving the
mouse. Similarly, you can zoom 3D charts by pressing the Alt key and moving the mouse's
scroll wheel.

Search Charts. The QAD .NET Ul’s browse search capabilities apply to the chart view as well
asthe grid view. By using the search capahilities you can interactively change the chart view
of the browse.

Hide Titles and Legend. Chart titles and legend are shown by default. You can hide (or show)
titles by right-clicking and selecting Hide Titles (or Show Titles). Similarly, you can hide (or
show) the legend by right-clicking and selecting Hide Legend (or Show Legend).

Launch in New Window. To launch a chart in a new window, right-click the chart and select
Launch in New Window.

Copy to Clipboard. You can copy the chart to the clipboard so you can paste it in other
applications. To copy the chart to the clipboard, right-click in the chart area and select Copy to
Clipboard.

Edit Chart Design. To return to the chart editor, select Chart Designer from the Setup menu.
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Interactive Charling

For any item that has a drill-down, display @
split-screen view of both the chart and the
drillF-down browse, which can also be
displayed as a chart

- Click anitem in the first chart fo automatically
change the view to reflect the changed data for
the drill-down

Click an item in the chart to select the
associated row in the browse

- Conversely, click arow in a browse to select the
associated item in the chart

For any item in the chart that has a drill-down, you can have a split-screen view of both the chart
and the drill-down browse, which can aso be displayed as a chart.

» When you click on an item in the first chart, the drill-down chart will automatically change to
reflect the changed data for the drill-down.

« Clicking on an item in the chart also selects the associated row in the browse.
» Conversely, clicking on arow in abrowse also selects the associated item in the chart.
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Operational Metrics

File Edit Tools Workspace Window Help

— || AR Operations *

& Applications

=% Metrics
:d. Addresses
[@ AP Operations
F)
[@ Banking/GL
(@ CSR Metrics - Order Lin
lg# CSR Metrics - Order Lin
(@ CSR Metrics - Orders
[@ CSR Metrics - Orders S
3 Customer Data
L@ Customer Support Diag
@ DRP

[@ Inventory Metrics

AR Operations

Customer Invoice Analysis (Current Quarter)

Name

Operational Invoices
Nos)

Financial Invoices (Nos)

Operational Invaices
(Value)

= Refresh @) Stop () Print 4] Print Preview

Result

39

21

1,514,475.64

| New 4 Edit~

Total

60

60

1,942,446.16

¢ Addto Favorites | kg Save 3§ Delete

&0 80 100

1] 20 40

—— o
1] 20 40 &0 80 100
— g | ——

0O 20 4 & 80 100
| |y

®

65%
35%

9% @

e -

3 Inventory Turns
lg Item ABC Code Metrics

- ltam Planninn Nata Infe
[} 2

Financial Inveices (Value) 27,970.52 1,542,446.16

1%@

Eis

¥ Favorites
US| Set Up General Ledger| ]
# &) Containerize Sales Order Ship

e

CalasClad

The Operational Metrics option lets you create a graphical metric from browse data. Operational
metrics provide alive snapshot of production data, which lets you monitor in real time how the

system is being used. You can use operational metricsto visually track any type of browse data,
including data from customized browses created in Browse Maintenance.

A number of predefined metrics are supplied with the system in the Metricsfolder. Inthis dlide, the
Accounts Receivable metric displays different customer metric results.

Metrics are created and managed by administrators using the Create Metric Collections function
on the Administration menu.
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Creating Metric Collections

[Unwed x
e Refresh &) Stop (=0 Print » Print Preview | | | New ¢ Edit | ' AddtoFavorites | [ Save 3£ Delete
Untitled

Total (Untitled) |

Title | S Customers By Site
Untitled

1 Select Create Metric Collection from the Administration menu to create the initial metric

collection. The system prompts you to name the collection.
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Creating Metric Groups

Creating Metric Groups
-
Y Create Metric Group - Hﬂg
Actions - | ONONCEC)
Search @
Viewing 1- 100 of 1484 Records per page: | 100 -
Name » Description View % Power Lockup SortColumns DragBack UserID Mod Date  Term |j
ab001 Customer Order Processing __wvwab001 Yes Ho 0 emb 10/2008 CUSTDMi E|
| 3 ad001 Customers cmmstr(1 Yes No 2 jpm 12722008 CUSTOME
ad002 Customer Controls Browse rcc_msir Yes No 0 mfg 726/2011 CUSTOM
2d005 Dock Addresses admstr| L e — (5|
=d006 y
Employees ety Tide | EHNTRIRINST] Beowme Program  adbel0lp
ad007 End User Addresses eumsir Unitied
ad008 Lddress List Types Ismstri |
[Search [7)
l ad010 Salespersons spmsirl| | £ =) | s @) - + x _5,,? [._(_'i‘"_".'_.
f| =2d014  Suppliers vdmstr]
| 2015 Country Codes ctry_m
ad016 Rounding Methods md_m|
ad022  Camiers admstr]
ad023 Customers and Ship-Tos Ismstri]
ad027 Ship Vias code _r|
e
L
o Carel

2 Right-click the collection title, or select Edit|Create Metric Group to create a metric group for

the collection.

3 Alist of browsesin the system displays so you can select the parent browse for the group.

Double-click the name of the browse to select it.

4 You are prompted to name the Metric Group. Enter a name for the metric group (for example,
Customers by Site) and click OK. The system then prompts you to create the first metric.
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Creating Operational Metrics

Y Create Metric - =
Title | Customers for Ste 10-100
Untitled 2 150

Type | Count - ~ | |Percent - 1 - m
(]
Search (1) @)
Site v | |equals - | 10-100 /.'_'[z - + X Clear All |
oK Cancel . |

L

Title. Enter atitle for the metric (for example, Customers at site 10-100).

Type. The default typeis Count. When you select the Count type, the browse filter drop-down
is unavailable. Type options depend on the type of browse. For browses that produce

numerical values asresults, you can also choose Sum, Average, Maximum, or Minimum asthe
Type option. When you select atype other than Count, you can then select the value to which

you apply the type.

Percent/Range. Select Percent to display the metric as a percentage of the browse total.Select
Range to display the metric as arange of figures. This option lets you increase the granularity
of the results.

Search. Select the browse filter, operator, and value to define the metric. For example, this
metric is based on the number of customers in Customer browse whose site code equals
10000. You therefore select the site code filter to equal 10000. You can set multiple filters for
the metric, as you do on anormal browse. Click Search to find out how many sites meet the
criteria (in this case, the number is 33). Thisinformation is displayed as a percentage of the
total (when you have selected the Percent display option). Use the dlider controls on the
percentage bar to set the color code for thresholds.
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Editing Operational Metrics

Gustcmer Details =

2 Rsfresh 0 2rim X PrirtPreview | | Wew g Edit | [ scdtoFavaries b Save 3 Do

=tamer Netails

Cuslirm s by Sile @
Harna Rasult Totzl

Custamers =t sit= 13000 33 113 U& LiJ Hl_l H‘” 'iLIU 29’:‘;’

Custamers ot sits 12000 & 113 U* Llu T#U 7%‘

Custcrrers at:itc;l‘l].:ltl_g " iia u 1 Llu t].l ] sl

Tctal (Custowress by 5 ted .
otal {Custcrrer Liatails) .

You can edit metric details by right-clicking the metric name on the main screen and selecting
Edit. Click on the Save button to save the operational metric to the Metrics folder, New to save the
metric for the first time, and Replace to replace an existing metric.

The metricis now availablein the Metrics folder. You can add operational metricsto Favorites. To
refresh the metric information, rerun the individual browses from within their metrics.
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Summary

Summary

« Browses let you to display selected data in
different formats

« You can use advanced filtering, sorting, and
column options to adjust the data you see
to your needs

+ You can display browse data as charts or as
operational metrics

- Operational metrics can be used to display
operational deficiencies in real time
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Exercise and Knowledge Check

1 Open up the Sales Order Browse. Highlight any Sales Order and drill down by double-clicking
a Sales Order number. In the Sales Order Maintenance screen that appears, click the Sold-To
lookup.

2 Goto Supplier Invoice View and display a component-based browse.

3 Use Sales Order Browse and limit the output of the Sales Order Browse to orders for one
specific customer.

What filter did you use? What operator did you use? Send the output to an Excel sheet.
4 From the Metrics folder, display the Accounts Receivable metric.
5 Run Excel Integration for Country Browse. Delete a country and re-import the Excel sheet.
6 Run Sales Order Browse and rearrange the columns. Group the results by Sold-To.

7 Use Chart Designer to create a chart for Item Master Browse.
Label the x axis Product Line and select the variable prod line.
Label they axislabel Part Number and select the variable item number and group by count.
Select a 3D pie chart and run the chart.
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Chapter 6

Using the Character Ul
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Chapter Objectives

Chapter Objectives

« To infroduce the functionality of Character
User Interface (Character Ul or CHUI)
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Chapter Benefits

Chapter Benefits

« You willbe able to use and navigate the
Character Ul of QAD Enterprise Applications
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Training Flow

Training Flow

« Introduction

+ Navigation

+ Application Help
- Programs

- Browses

- Character Ul

- Dashboards
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Introduction to Character Ul

Infroduction to Character Ul

« Character Ul depends on input from the
keyboard

- A command-prompt interface to execute
programs

- Combinations of keystrokes to issue commands
withinprograms

- Navigationwithout use of a mouse through the
UNIX characterinterface
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Character Ul Login Screen

Character Ul Login Screen

P 172.16.28.81 - PuTTY M=%
[~

b e R pR S S RS RS NS o T | KRS PR R o i
QAD Enterprise Applications 2010 - Enterprise Edition as of Feb 24 2010
QAD
100 Innovation Place
Santa Barbara, CAL 93108

{805) 684-6614
{805) 565-4202 FAX

Copyright 1986-2009 QAD Inc:.  All rights reserwved.
This product mway not be reproduced or distributed
Aetive Users: Defined Users:

User ID: .

Password:
Domain:

Enter data or press F4 to end. |»

To start acharacter session, follow the procedures provided by your system administrator. Thefirst
screen you see after launching the system lets you log in to the system. Enter the login ID assigned
by your system administrator and your password. If you have been given access to more than one
domain in the system, enter its name in the Domain field. If you have access to only one domain,
this domain displaysin read-only mode. You must be avalid user to log in. Your password can be
blank only if the password in your user record is blank.
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Main Menu
#P172.16.28.81 - PuTTY =Joed
QME US : gaddb -~

‘mfmenu Main Menu 05/26/10
1. Items/Sites 13. Product Structures 25. General Ledger
2. hddresses 14. Routings/Work Center 26. Multiple Currency
3. Inventory Concrol 15. Formula/Process 27. Acocounts Receivable
4. Warehousing 16, Work Orders 28, Avcounts Payable
5. Purchasing 17. Lean Manufacturing 29. Tax Management
6. 18. Repetitiwve 30. Cost Management
7. Sales Orders/Invoice 19. Quality Management 31. Banking/Cash Mgmt
8. Configured Products 20, Product Line Plan 32. Fixed hssets
9. 21. Resource Plan 33. Enterprise Ops Flan
10. 22. Forecast/Master Plan 34.
11. Service/Support 23. Materials Rgmts Plan 35. EDI eCommerce
12. Distribution Plan 24, Capacity Repcs Plan 36, System Admin

Please select a function. F4 or blank to EXIT ||

Press Fz for Help [ne]

QAD Enterprise Applications has locations for 36 modules on the character-based main menu. In
turn, each modul e has one or more menus attached to it. Menus are lists of programs you use to
look up or input data.

The menus that you see depend on the security access that has been granted to your role. Only
menus with programs that you have access to display. When you enter a menu number on the
command line, the system either executes aprogram or displays alower-level menu. You can keep
drilling down through the menus until you reach the appropriate level. Alternatively, you can
access a program directly by entering its Progress name—such as ppptmt . p for Item Master
Maintenance—or number at the command prompt.

If the current menu displayed is System Admin (36), you can enter 2.13 to access Generalized
Codes Maintenance. However, you must enter .1.4.1 to run Item Master Maintenance (1.4.1)
because it is on a different submenu.

You can also use the arrow keys to move around the menu, then press Enter to execute the
highlighted selection.
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Menu Substitution

Menu Substitution

£ 172.16.28.81 - PuTTY ==

ucnsSmt . B 3+

HNew Execution File: frmmaig.p
Jelection Label Term: FORMULA CODE_INQUIRY
Formula Code Inguircy

Fl=Go 2=Hlp 3=Ins 4=End 6=Mnu 7=Rcl S=Clr 9=Prev 10=Next 11=FBuf |$

Menu substitution lets you toggle between displaying browses and inquiries on the menu. You can
also useit to switch between customized and non-customized versions of a program. The system
administrator can use Menu Substitution Maintenance (36.4.4.7 in EE, 36.20.6 in SE) to specify
which programs are substituted for others when you select this option. By default menu
substitution is disabled. It can be enabled for individual usersin User Maintenance (36.3.1).
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Program Screen Elements

Program Screen Elements

P 172.16.28.81 - PuTTY

Tifle bar zosomt.p 34 7.1.1 3ales Order Maintenance 05/26/10
i Purchase Order: !OSl Supplier: 505800 Ship-To: US-W-S ‘
Supplier Ship To
Sandwich Factory us-w-3
PngrOm = Storey Street 530 1 California Boulevard
Window
Vickery COH OH43454 San Diego Ch 92104
UNITED STATES UMITED STATES
Order Date: 07/08/07 Price Thl: Confirming: Yes Imp/Exp: No
Due Date: 07/08/07 Disc Thl: Currency: USD Language: us
Do Buyer: Ln Disc: 0.00 Taxable: No H
o e Bill Ta: US-W-5 Site: US-W-S  Fixed Price: Yes Consign: No
Frarme Sales/Job: Daybook Set: Def AP  Credit Terms: 2N 0.00
Contract: Project: Entered By: lvh
Contact: Requested By:
Remarks: Comments: No
Progress
Stortus Bar F1=Go 2=Hlp 3=Ins 4=End 6=Mnu 7=Fel §=Clr 9=Prev 10=Next 11=Buf

Thetitle bar identifies the program currently running. What displaysin the title bar depends on the
Header Display Mode setting in Security Control (36.3.24). Based on that setting, you may see any
of the following elements:

- Thetitle bar includes—from left to right—the program name, the version of the program, the
menu number and title, and the current date.

» Thetitle bar is the same as previous except that the login ID of the current user replaces the
current date.

- Thetitle bar includes—from I eft to right—the short name and currency of the current working
domain, the menu number and title, and the current date.

» Thetitle bar is the same as previous except that the login ID of the current user replaces the
current date.

Program Window

 The program window displays the frames and fields of the current program.
Progress Status Bar

« The status bar shows the basic commands needed to navigate through the specific program
currently displayed in the program window.
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Character Ul Browse

Character Ul Browse

P 172.16.28.150 - PuTTY =<
: [ ERES SR 2R Tl
User Menu Edit Options Help Type mn [l
o5/26/10
Type Description /28!

Trans Type:[|_ >FA Fixed lssets

Trans Type Doz Type From Ic Inventory Control ook

S0 Sales Orders

> W Work Crders SDEB

Ic FDEBE

Ic CET-ADJ [=1=1=14

I1c I23-PRV PRV

1cC I38=-30 S0

Ic ISS-UNP UNF

1c ISS-w0 WOISS

ic MATL-VAR WOMVAR

Ic RCT-FOQ RCT-FQ

Ic RCT-5CR RCT-3CR
Filter = Qff
F1=Go 2=Help 3=Ins 4=End 6=Nenu 7=Rcl 8=Clr 1l=Paste v

Browses display selected datain the form of atable. Browsesin the character Ul are similar to
thosein the .NET Ul, but have asimpler set of features. Two types of browses are available:

« Lookup browses return the value you select to the active field in the calling program.
« Drill-down browses display, filter, or print data.
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Browse Menu Bar

Browse Menu Bar

#P172.16.28.150 - PuTTY E]g
PESSREA Edit Options Help |
Defined in
USBI’ FUI’]CﬁOﬁ order Maintenance| Default Daybhook EBrowse 05/26/ lU‘
maintenance Print  CTRL-P
un Program. .. = ncicy o Entity avhoo
ancar Run P CTEL-R Enti To E Daybook
Menu Exit ESC-X
f USSYSDE
Maintenance s ICDEFDS
IC CET-ADJ std cost
IC IS3-FRV He 11|
c  |ISs-30 i
IC IS3-TFP Fontents
IC IS3-Wo ;| Interface Help
IC MATL-WVAER
IC RCT-FO Field Help
IC RCT-50FR Procedure Help SHIFT-F1
‘| Drill-Down ESC-TAE
Filter = Off Look-up Browse FZ
Aoouc. .. CTRL-F1 L
i

To scroll through the records, use the Up and Down arrows.

The User Menu in the browse menu bar differs from the User Menu accessed by pressing F6. The
User Menu in the browse menu bar provides access to:

« Print Options
* Run Program
- Exit

Edit

Cutting text deletes it from its current location and copies it to the clipboard. Copying is similar,
but it leavesthe original text in place. In both cases, you can paste the text to another location, such
asafield.

1 Choose the text to cut or copy.

2 Display the Edit Menu. This menu choice is available only when text is selected.
3 Choose Cut or Copy.

4 Position the cursor in the new location.

5 Choose paste.
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Options
» Browse Options. Use this option to set up filter criteriafor browses. Thefilter criterialimit the

viewable records according to your specifications. For example, you can filter out product
numbers or statuses that you do not want to view.

 Toggle Filter: Use the toggle filter setting to turn on and off the filter criteria set up in the
browse filter options.

Help

Use this menu to access help on fields, aswell as display drill downs and lookup browses on
selected fields. The fastest way to get help for the current field is by pressing F2 twice: press F2
once and, if available, alookup browse displays) but you can aso bring it up with the Help menu.
With the cursor in the field, drop down the Help menu and choose Field Help and procedure help.

Output Devices

You can send the output from reports, inquiries, and browses to anumber of devices, including the
following:

« Your terminal
A server printer
« An e-mail message

However, the character user interface does not offer as many options asthe QAD .NET Ul. You
can send output to Terminal or page, but not to Window. If you select Window, the system displays
an error message. The Winprint option is designed only for Windows clients. If you select this
option, the system displays an error message. Otherwise, the output options are the same in both
interfaces. If you select a printer as the output device, be sure to use one that has been defined with
adestination type of Default in Printer Setup Maintenance (36.13.2). Just asin the QAD .NET U,
you cannot use e-mail unlessit has been set up properly.
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Summary

Summary

The Character Ul is available for SE and EE

- In EE, component-based functions are accessible
only through the QAD .NET Ul

- Used mainly for highly repetitive heads-down
operator transactions

Exercise

Isthe .NET Ul or the character version a better option for your company? Why Or why not?

Go to the sold-to field in Sales Order Maintenance and pull up the drill-down browse, field help,
and procedure help. What key or keys did you use?
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Objective

Objective
- Learn about dashboards in the QAD .NET Ul

- Benefits

- Dashboard Example

- Sample Dashboards

- Dependencies

- How to access QAD Dashboards
- Creating a new dashboard

- Hands-on dashboards

- Dashboard configuration

MQAD



Dashboards in the QAD .NET Ul 131

Benefits

Benefits

- Brings it all together

- Essential data at a glance

+ Data from browses, metrics, Bl, and web pages
- Easy to customize

+ Role-specific

« Sample dashboards available on QAD Store
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Training Flow

Training Flow

« Introduction

+ Navigation

+ Application Help
- Programs

- Browses

« Character Ul

- Dashboards
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Dashboard Example

Dashboard Example

Extended Prce » 00000

Sales Order Detail Browse
[T |

customer

Revenue

ok Thursday, September 12. 2011 1003 4

b of Thursday, September 12, 2013 1003 A4 2o of Fridey, Juy 25 2013348 P

Top 25 Cumtamens by Domam and Financal Year + na nite. O

QAD Dashboards bring together browses, web pages, business intelligence, and metrics within
panels. For example, this slide shows a dashboard you could create to review Large Customer
Orders. The dashboard includes panels that provide information from Sales Order Detail Browse
(using a chart view), Sales Order Browse, a Customer Orders metric, a Top 25 Customers by
Domain and Financia Year — Business Intelligence (Bl) view, and a panel for the QAD web site.
Each panel offers a quick summary; to find out more, you click on the panel to open the item, such
as a browse, within which you can drill-down further for more detailed information. As a user, you
can create, copy, and modify dashboards like this one directly in QAD .NET Ul. Further, you can
save one or more dashboards as favorites and have them open automatically when you log in to the
QAD .NET Ul. Asan administrative user, you can publish dashboards for use by othersand assign
them one or more user roles defined in the system.
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Sample Dashboards

Sample Dashboards

Sample dashboards available for download from
the QAD Store

- Customer Management Sample Dashboards
Financials Sample Dashboards
Manufacturing Sample Dashboards

Three packages of sample dashboards (Customer Management, Financias, and Manufacturing)
are available for download from the QAD Store. You can copy and customize these sample
dashboards to meet your specific requirements.
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Dependencies

Dependencies

- QAD .NET Ul 3.0.1 (with 2013.1 EE)
+ QAD Business Intelligence (Bl) 3.9

- Required for Bl panels in dashboards

« QAD Operational Metrics

- Required for metrics panels in dashboards
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How to Access QAD Dashboards

How to Access QAD Dashboards

QAD NET Ul @ Applications
Dashboards > Create [ Menu Search
Dashboard # 3 Collections
Dashboards > i :::" Fee
My Dashboards r_:‘TE W—
Dashboards > {2y Create Dashboard

: + =) My Dashboards
Published Dashboards [ Published Dshbosrds

To access QAD Dashboards, inthe QAD .NET Ul, simply navigate to the Dashboards folder in the
Applications pane. In the Dashboards folder, you will see the Create Dashboard selection, with
which you can immediately start creating new dashboards. Under Create Dashboard, we have two
folders: My Dashboards and Published Dashboards. When you create new dashboards, the
dashboards are placed in My Dashboards. When dashboards are made available for your use based
on your user role, these dashboards are placed in Published Dashboards.
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Creating a New Dashboard

137

Creating a New Dashboard
@ Applications : = !Pmces:es 2 [Unliﬂed X |
ooy Qe Dashboard Untitled ~ - Add Content ¢ Tools - |2} Save Dashboard M Cancel
+ (3 Collections
¥ (= Home Page Add Content to Dashboard =]
# (5 Metrics
=} "% Dashboards H  Browse
B2 Create Dashboard | el x
D i Dogklands: Browse —3
 d 1098-MISC Box View (BBox1098 View 3
() Published Dashboards i {'M”;:';f il =
i @ Action Message Browse (drbr002.p) 3
& —1' Supply Cha}n A Active Customer Sequence Browse (rebr(09.p)
# {3 Manufacturing = URL Add Flow Lines (fibr004.p)
& {3 Financials I Additional Charges Browse (fsbr063 p)
# (3 Master Data H AP Address Type View (BAddressType View)
* () System Administration ' Address \Whse Detail Browse (whbr051.p)
# () Processes . Algorithm Assignment Browse (whbr(45.p)
# {5 Administration . BI Algorithm Master Browse (whbr(432.p)
) Q¥tend H Algorithm Type Browse (whbr(44.p)
B Cj 211 Call Browse (fsbr089.p)
i 2 4 Alternate COA Group View (BARCOAGroup. View)
I bavoies Altemate COA Structure View (BACOAStruct View)
[ Sales Order Browse MEICS | Aptamate Routing Browse (rwbe001.5)
Alternate Task Browse (whbr068.p)
Alternate Unit of Measure Erowse (whbe010.p)
Analysis Code Browse (ppbr112.p)
Analysis Code Detail Browse (ppbr120.p)
Analysis Code Selection Browse (ppbr113.p)
Analysis Code \here-Used Browse (ppbr121.p) E
Back | Configure | | Add to Ca&nboa!u]
' Guick Search

Inthe QAD .NET UlI, to create a new dashboard, you simply click on Create Dashboard and get

started with adding Browses, URL sto web pages, Bl views, and Metrics. From the Add Content to
Dashboard pane, you can select the kind of content you want to have in the various panels of your
dashboard. By default, you can add up to 12 panels on a dashboard, but this default can be changed
by an administrator. Also, note that you can double or triple the size of browse and metrics panels

so that the datais more readily accessible.
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Hands-On Dashboards

Hands-On Dashboards

File Edt Tools Workspace Window Help
@ Aoplicasons E 1 ]

Irventory %
Dashboard Irventory = 3¢ Tools = {3 Edit Dashboard () Refresh

# (3 Collecsons
# (] Home Page

Iveniary Velus by ABC Code (] mvenary Value by ABE Code (9]
A Hevrs Irvertony Value T hewvs Invertory Value
199% 190%,
Bt
0% )
&) L
E
) S —
weea | v
Ag of Tusaday. August 27. 2013 3:48 AN Ao of Tuesday. August 27. 2013 348 AN

[ Sales Order Browse Cost Set = 'standaid’

Inventory Valuation by Site

[iv,m [ =

LR

I Guick Search .

s

A of Thursday. Sepembes 12 2013 1012 AN

Now start the QAD .NET Ul to explore how to use and customize dashboards.

1 Goto Dashboards > Create Dashboard.(Alternatively open a dashboard and choose Tools >
New.)

2 Let'sadd abrowse pand. In the Add Content to Dashboard window,
3 Click Browse

Search for a browse of interest, such as Sales Orders (sobr103.p).
Set Price to be greater than 10,000.

Change Title to: Sales Orders Over 10K.

Preview the browse results.

Click Add to Dashboard.

o N o o A

Next, let's add a metric panel.
1 Click Add Content.
2 Click Metric.

3 Search for ametric of interest. For example, choose Sales Orders.
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4 Click Configure.

5 Click Metric Gauge.

6 Click Past Due Orders.

7 Click Add to Dashboard.
Now save the dashboard:

1 Click Save Dashboard.

2 Inthe Save dialog, enter a name for the dashboard. You can enter text here but | recommend
that you first check to seeif alabel isavailable that would be applicable. By using an available
label instead of text, you can be sure that thetitle of the dashboard will be translated. For this
example, let’'s use the label ${ SAMPLE}, which will display in English as “Sample”.

3 When done, click Save Dashboard.

Now, looking back at the Applications pane, under My Dashboards, note that the new dashboard
you've just created islocated under My Dashboards. However, it is not located under Published
Dashboards.

Edit the new dashboard further:

1 Open the dashboard and click Edit Dashboard. Notice how when you are in edit mode alight
gray grid isdisplayed in the background. Thisisto help remind you that you are in edit mode.

2 Now let’s consider the icons near the lower left corners of our panels. You can double or triple
the width of browse panels and metrics panels.

3 Click onthetriple-width icon for the browse panel. Note how the browse panel triplesin width
and then the metrics panel automatically moves below the browse panel for you.

4 Click Save Dashboard. (Notice the light gray grid is no longer displayed when you are not in
“edit mode”.)

Add some more panels to the dashboard. (By default, we can add up to twelve panels but that limit
can be changed by an administrator.)

1 Open the dashboard and click Edit Dashboard.
2 Inthe Add Content to Dashboard window, click URL.
3 IntheTitlefield, enter Google.

4 Inthe URL field, enter aURL to aweb page. For example, www.google.com. Note that QAD
Shell Links (gadsh://) links are not currently supported for use in the URL field.

5 Click Preview to verify the view of the web page.
6 Click Add to Dashboard.
7  Click Save Dashboard.
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You can change the configuration of the panels on the dashboard. To see how, edit the dashboard.
Notice the icons along the upper right corner of each panel. There are three of them: a gear, a
circular arrow, and an X. The gear isfor editing the panel configuration, the circular arrow isfor
refreshing the panel display, and the X isfor deleting the panel.

On the URL panel, click on the gear icon and change the URL from www.google.com to
maps.google.com.

Similarly, you can change the configuration of browses, metrics, and so on. For example, you
could change the search filters on a browse display panel.

Take alook at the dashboard tools options.
1 From the dashboard, select Tools.

2 From Tools, you can start a new dashboard, make acopy of the dashboard (which you can then
edit and customize), rename the dashboard (that is, give it a new titl€), and delete the
dashboard.

3 Next, under Tools, if you are an administrator, you will have a Publish option. When you
publish a dashboard, you have options to rename the dashboard and to assign the dashboard to
user roles previoudly defined in the system.

4 Finaly, under Tools, note the Export and Import options. With these options, you can export
the dashboard definition as an .xml file and then import the .xml file to another system.

You can add a dashboard as a favorite and then set that favorite to auto-start so that it opens
automatically when you log in. For instance:

1 Inthe Applications pane, right click on the Sample dashboard.
2 Choose Add To Favorites.
3 Under Favorites, right-click on Samples and choose Auto Start.

4 Now this dashboard will open automatically when you log in to the Ul again.
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Dashboard Configuration

Dashboard Configuration

« Check dashboard setttings from QAD .NET UI:

+ Help > Configuration, Search: dashboard
- Dashboard Admin Roles
- Dashboard Max Panels (12 default)
- Dashboard Padding
- Dashboard Provider Colors

- Bl access: Bl URL Setting
- Dashboard configuration set by system admin in

client session configuration file on home server
(client-session.xml)
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Summary

Chapter Summary

- Dashboards provide essential data at a glance
« Data from browses, metrics, Bl, and web pages
« Easy to customize

+ Role-specific

- Sample dashboards available on QAD Store
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Exercise and Knowledge Check

1 With QAD Dashboards, can all of the following be included in dashboard panels?
» Browses
 Operational Metrics
 Business Intelligence (BI)
» Web Pages

N

When you create a new dashboard, where is the dashboard saved on the QAD .NET Ul menu

w

What is the maximum number of panels you can have on a dashboard by default?

4 Canyou double or triple the width of a browse panel?

a1

Can dashboards be assigned to user rolesin the system?
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